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Western Sydney Chronic 
Condition Management  

 

     Continuous Quality Improvement Toolkit 
  

 

The Chronic Conditions Management (CCM) QI Toolkit provides a practical guide to help general 

practices implement continuous Quality Improvement (QI) activities for managing chronic 

conditions.  

It supports primary care teams in delivering structured, proactive, and person-centred care - 

enhancing continuity, improving patient outcomes, and increasing efficiency. The toolkit aligns 

with the revised CCM MBS items and the Strengthening Medicare reforms.  
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get help?  

 

Western Sydney Primary Health Network 

E: support@wentwest.com.au 

P: (02) 8811 7117 
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http://www.wentwest.com.au/
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Navigating this toolkit 
This toolkit includes practical, flexible activities that are not sequential. We recommend starting 

with Section One – Practice Readiness to assess your current state.  

Use the links below and this icon to navigate directly to each activity section. 

 

 

 

Use the Model for Improvement and Plan-Do-Study-Act (PDSA) cycles. to test changes, drive progress, and 

embed high-quality chronic condition care aligned with MyMedicare and upcoming MBS reforms. 

01 Introduction 

03 Module 1: Leadership – Preparing your practice 

1.1 Pre-Activity – Practice Readiness Checklist 
1.2 Activity – Preparing your practice for CCM QI Action 
1.3 Activity – Communication Action Plan 
1.4 Activity – Practice Change (QI) Plan 
1.5 Activity – Practice Meeting template 

 

11 Module 2:  Patient Registration & Engagement 
2.1 Activity – Reminders, Registration and Flagging 

2.1.1 Management registration via HPOS 
2.1.2 Best Practice – CCM, MyMedicare Registration and flagging 
2.1.3 Best Practice - My Health Record & MyMedicare Registration 
2.1.4 Medical Director – MyMedicare Registration and flagging 
2.1.5 Medical Director - My Health Record & MyMedicare Registration 

2.2 Activity – Scripts: phone, SMS, email, and website 
2.3 Activity – GoShare Patient Engagement Platform 
2.4 Activity – Check the number of allied health service 

 

22 Module 3: Data-Driven Improvement 

3.1 Activity – MyMedicare patients 
3.2 Activity – Patients not registered with MyMedicare 
3.3 Activity – All CCM Patients due for a care plan and reviews 
3.4 Activity – Patients with a chronic condition eligible for care plan or review 
3.5 Activity – Patients with risk of hospitalisation eligible for care plan or review 
3.6 Activity – Filter by assign provider 
3.7 Activity – Create a prompt to display in Topbar 

 
 

30 Module 4: Team-based care approach 

4.1 Activity – Business Optimisation for CCM 
4.2 Activity – CCM Claiming Annual Cycle of Care 
4.3 Activity – Allied Health Referrals and other GPCCMP considerations 
4.4 Activity – Roles and Responsibility (Swim Lane workflow)  
4.5 Activity – Sample CCM Nurse workflows 
4.6 Activity – CCM Appointment workflows 

 
 

37 Appendices 

5.1 Quality Improvement documentation 
5.2 PDSA – Team awareness, desire and readiness 
5.3 PDSA – Identifying Active Patients & Linking to MyMedicare Program 
5.4 PDSA – CCM and MyMedicare 
5.5 PDSA – Reducing Missed Appointments for Management plan reviews 
5.6 Measuring Outcomes – Audit Worksheet  
5.7 Group reflection – after completing activities 
5.8 Useful contacts 
5.9 MBS Quick Guide 

 

https://wentwest.com.au/wp-content/uploads/2025/02/Model-for-Improvement-and-the-Plan-Do-Study-Act-1.jpg
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
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Introduction  
 

From 1 July 2025, the most significant reforms to chronic 

disease management in over 20 years 

Major changes to the MBS framework for chronic disease 

management in primary care will come into effect. These changes 

implement the recommendations of the MBS Review Taskforce.  

 

 

 

Chronic conditions affect  

61% of Australians 

15.4 million people, including nearly all 

aged 85+. As demand for connected, 

multidisciplinary care grows, chronic 

conditions are driving major pressure 

on individuals and the health system. 

Key changes:  

• A single GP Chronic Condition Management Plan (GPCCMP) replaces GPMP and TCA. 

• All previous items (721, 723, 732, 92024–92028, etc.) will be ceased and replaced. 

• Equalised fees for preparation and review of plans ($156.55 for GPs) 

 

Refer WentWest MBS guide for the frequently used items including Care Planning 

and incentives This guide links item number to MBS criteria, descriptor and fact 

sheets. 

MyMedicare: 
• Patients registered with MyMedicare must 

have plans and reviews provided by their 

registered practice. 

• Unregistered patients can continue to access 

plans and reviews through their usual GP. 

Other changes:  

Patients with at least one chronic or terminal 

condition will be eligible. 

Practice Nurses, Aboriginal and Torres Strait 

Islander Health Practitioners, and Aboriginal Health 

Workers can now assist in preparing or reviewing a 

plan. 

A plan can be prepared once every 12 months, and 

reviews can occur every 3 months. A new plan 

each year is not required—existing plans can be 

reviewed. 

Domiciliary medication management reviews will 

require a new-style management plan from 1 July 

2027. 

Multidisciplinary care plan items (e.g., for aged 

care) remain unchanged  

Current plans remain valid during a 2-year 

transition period until 30 June 2027. 

 

Referring to Allied Health: 

• No need for two collaborating providers to 

initiate plan anymore—this requirement has 

been removed. 

• Referral letters will replace existing allied 

health referral forms. 

• Patients must have had a plan prepared or 

reviewed within the last 18 months to access 

MBS-funded allied health services. 

 

Service GP Item Number Fee Replacing 

Prepare plan - face-to-face 965 $156.55 721and 723 

Prepare plan - video 92029 $156.55 92024 and 
92025 

Review plan - face-to-face 967 $156.55 732 

Review plan - video 92030 $156.55 92028 

 

MBS CHANGE 

ITEM & FEE 

https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Upcoming%20changes%20to%20the%20MBS%20Chronic%20Disease%20Management%20Framework
https://www.health.gov.au/our-work/mbs-review?language=en
https://bit.ly/4kSlNXe
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Tools and Enablers  
At WentWest, we are investing in the best tools and enablers to help health professionals drive CQI. For user 

access, contact us support@wentwest.com.au or call 8811 7117 

  

GP Support 
Line 

GPs have direct access to Local Health District specialist advice and escalation 

options through the Rapid Access Stabilisation (RAS) Service for three streams; 

Cardiology, Endocrinology and Respiratory . Access by calling GP Support Line 1300 

972 915 (Mon-Fri 9am-7pm). 

 

Primary Mental 

Health Care 

Primary Mental Health Care funds psychological services for vulnerable groups, 

offering up to 9 sessions with a general referral or 12 for those at risk of suicide. GPs 

must submit a PMHC referral form with patient consent. Alternatively, Initial 

Assessment and Referral (IAR) levels support easy referral pathways. 

 

Developed by local GPs, specialists, nurses and allied health providers, Western 
Sydney HealthPathways supports health professionals by providing local, relevant 
information on managing medical conditions and referral options for their patients.  

A login is required.  

HealthPathways 

GoShare 

GoShare is a free patient education platform that allows general practices to share 

tailored and up-to-date resources (including videos and fact sheets) with patients. 

There are specific Heart Health Check GoShare bundles that can help increase 

health literacy and enhance patient awareness and engagement.  

Heart Foundation 

Walking Groups 

The Heart Foundation Walking Groups are free and are effective in encouraging 

people to increase their physical activity which can help prevent and manage 

diabetes, cardiovascular, mental health and their weight. Join a walking group and 

make every step matter.  

 

Remote 
Monitoring and 

Screening 
Devices 

Continuous Monitoring: HeartBug ECG is a single led ECG allows real-time remote 

monitoring of patients with suspected arrhythmia. While the Kardia Mobile allows 

quick (30secs), accurate ECG ideal for screening and enabling early detection of 

Atrial Fibrillation, a key risk factor for stroke. 

Pen Computer System (CS) suite, including CAT4 and Topbar, enhances clinical data 
accuracy and decision-making, with WentWest funding access for all Western Sydney 
practices. Our Data Dashboard and Reports support QI through data-driven initiatives, 
risk stratification, and predictive modelling including Lumos – data linkage program. 

Pen CS Suite and QI 

Dashboard  

Pharmacist in 
General Practice 

The Western Sydney Pharmacist in General Practice Program integrates non-

dispensing pharmacists into general practices to provide clinical and educational 

services as part of a collaborative, patient-centred care team. 

mailto:support@wentwest.com.au
https://westernsydney.communityhealthpathways.org/154567.htm
http://www.westernsydney.communityhealthpathways.org/
http://www.westernsydney.communityhealthpathways.org/
https://westernsydney.communityhealthpathways.org/215760.htm
https://wentwest.com.au/health-professionals/programs-and-priorities/mental-health/primary-mental-health-care-services/
https://iar-dst.online/#/
https://iar-dst.online/#/
https://westernsydney.communityhealthpathways.org/welcome?returnUrl=%2f13454.htm
https://westernsydney.communityhealthpathways.org/welcome?returnUrl=%2f13454.htm
https://wentwestlimited-my.sharepoint.com/personal/mahas_wentwest_com_au/Documents/QI/Diabetes/healthily.com.au/goshare/
https://goshare.realtimehealth.com/conditions/561
https://walking.heartfoundation.org.au/walking
https://walking.heartfoundation.org.au/walking
https://walking.heartfoundation.org.au/walking
https://heartbug.com.au/
https://www.kardia.com/
https://www.pencs.com.au/
https://www.health.nsw.gov.au/lumos/Pages/default.aspx
https://wentwest.com.au/health-professionals/programs-and-priorities/chronic-condition-prevention-and-management/western-sydney-cardiology/
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Module 1 
 

Leadership - Preparing your practice  
 On completion of this module, you will: 

• Evaluate your practice’s readiness to implement MyMedicare and  
Chronic Condition Management 

• Engage the entire practice leadership team to confirm MyMedicare registration status and ensure 
readiness for the transition 

 

MyMedicare and Chronic Conditions Management (CCM) Foundations 

MyMedicare is a Voluntary Patient Registration (VPR) model that connects patients with their preferred general 

practice and care team to promote continuity and comprehensive care.  

By choosing a MyMedicare practice, patients formalise where GPCCMP MBS items can be accessed. This 

connection strengthens relationships and ensures proactive care planning for long-term conditions. 

Chronic Conditions MBS items support primary care providers to develop plans and continue to actively manage, 

monitor, and coordinate ongoing care with other providers working as a multidisciplinary team, for patients 

diagnosed with a chronic condition that is expected to impact their health for longer than 6 months.  

GPCCMP items also support access to allied health and other services for patients that would benefit from 

multidisciplinary team care to manage their chronic condition.   

For more information, refer to the Services Australia Fact Sheet – Overview of MBS Changes 

 

  Practice Resources: 

• CDM Changes – Overview 

• CDM Changes – Transition Arrangements 

• CDM Changes – Referral Arrangements  

• CDM Changes – GPCCMP MBS Items  

• CDM Changes – Allied Health Providers  

• CDM Changes – Practice nurse, Aboriginal 

Health workers and ATSI Health Practitioners  

• MyMedicare - Service Australia e-learning   

• RACGP summary of CCM changes 

• MyMedicare - Translated resources 

• MyMedicare - GP Communication Toolkit 

• MyMedicare - Practices and providers 

• Western Sydney HealthPathways 

• RACGP - Chronic disease 

• RACGP – Preventive Activities (the Red Book)  

MyMedicare Practice Registration: 
 
• Link your organisation in PRODA to HPOS 
• Access the Organisation Register in HPOS to 

register your practice and link your eligible health 
care providers 

• Add MyMedicare to ‘My Programs’ in HPOS 
• Ensure practice staff have appropriate 

delegations to access MyMedicare on HPOS 
 
Learn more: 
• Service Australia’s MyMedicare 
• Our MyMedicare Practice Registration Guide  
• Our MyMedicare Practice Readiness Checklist  
 
 

Eligible Patients registered with MyMedicare can only access GP Chronic Condition Management Plan 

services (face-to-face or telehealth) at their MyMedicare registered practice location, delivered by any 

eligible provider (including GP registrars) there, not other practices or locations.  

. 

https://www.health.gov.au/our-work/mymedicare/about
https://www.health.gov.au/our-work/upcoming-changes-to-mbs-chronic-disease-management-arrangements
https://www.mbsonline.gov.au/
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20-%20Overview.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20MBS%20Items%20%E2%80%93%20Transition%20Arrangements%20for%20Existing%20Patients.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20%E2%80%93%20Referral%20Arrangements%20for%20Allied%20Health%20Services.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20-%20GPCCMPs.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20framework%20-%20Allied%20Health%20Providers.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20frame~%20and%20Aboriginal%20and%20Torres%20Strait%20Islander%20health%20practitioners%20and%20workers.pdf
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20changes%20to%20chronic%20disease%20management%20frame~%20and%20Aboriginal%20and%20Torres%20Strait%20Islander%20health%20practitioners%20and%20workers.pdf
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://www.racgp.org.au/advocacy/advocacy-resources/summary-of-changes-to-chronic-disease-management
https://www.health.gov.au/our-work/mymedicare/resources
https://www.health.gov.au/resources/publications/mymedicare-gp-toolkit?language=en
https://www.health.gov.au/our-work/mymedicare/practices-and-providers
https://westernsydney.communityhealthpathways.org/13454.htm
https://www.racgp.org.au/clinical-resources/clinical-guidelines/guidelines-by-topic/view-all-guidelines-by-topic/chronic-disease
https://www.racgp.org.au/clinical-resources/clinical-guidelines/key-racgp-guidelines/view-all-racgp-guidelines/preventive-activities-in-general-practice/about-the-red-book
https://www.servicesaustralia.gov.au/proda-provider-digital-access
https://www.servicesaustralia.gov.au/hpos?context=20
https://www.servicesaustralia.gov.au/register-organisation-register-hpos?context=20
https://www.servicesaustralia.gov.au/hpos?context=20
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://wentwest.com.au/wp-content/uploads/MyMedicare/MyMedicare-Organisation-Registration-Guide-for-General-Practice.pdf
https://wentwest.com.au/wp-content/uploads/MyMedicare/MyMedicare-Readiness-Checklist-for-General-Practice-1.pdf
https://www.health.gov.au/our-work/mymedicare/patients#eligibility
https://www.health.gov.au/our-work/mymedicare/practices-and-providers
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1.1 Pre-Activity – Practice Readiness Checklist 

Before commencing your activity, evaluate your practice’s readiness to implement  

MyMedicare and CCM. Engage your leadership team to confirm registration status  

and ensure a smooth transition.  

Step 1 Actions Assigned to 

Plan the 
transition 

☐ Nominate a CCM change lead and team  

☐ Document the change plan, timeline, patient registers, and team responsibilities 
Need help? contact your WentWest Primary Care Facilitator 

 

☐ Meet with the team, define team roles, responsibilities, and timelines  

☐ Conduct data cleansing and archive inactive records   

☐ Set up a shared folder for documentation (e.g. Teams/Google Drive)  

☐ Coordinate audits and maintain up-to-date patient registers (Use CAT4 recipes)  

☐ Schedule regular team meetings to track progress  
 

 

 

Step 2 ACTIONS Assigned to 

System & 
Resource 
Setup 

☒ Register practice and providers in PRODA  

 

☐ Assign team in PRODA organisation 
account delegations and permissions  

 

☐ Add MyMedicare to ‘My Programs’ in HPOS  

☐ Update workflows, templates, and policies (if needed)  

☐ Allocate team time for updates and training  

☐ Audit existing CDM resources and store centrally for ease of access 
 

 

 

Step 3 ACTIONS Assigned to 

Prepare 
your team  

☐ Train the team in MyMedicare benefits, registration and CCM changes  

☐ Define roles and workflows (use the Swim Lane template)  

☐ Allocate protected time for each team member’s transition role  

☐ Provide regular updates to the team via internal communication  

☐ Refer clinicians to HealthPathways for the latest guidelines and referral 
pathways 

 

☐ Brief Allied Health providers on upcoming changes (refer to Referral 
Arrangements for Allied Health Services) 
 

 

‘ 

Step 4 ACTIONS Assigned to 

Patient 
Engagement 
& 
Registration 

☐ Use MyMedicare Communication kit (brochures, posters, videos, website & 
social media) 

 

☐ Ensure reception staff register patients opportunistically and invite others 
(SMS, email, or in-person) 

 

☐ Communicate the shift from CDM to CCM to patients (use GoShare)  

☐ Assist patients with form completion or digital registration   

☐ Confirm who will add/invite patients to MyMedicare via PRODA. Make sure to 
enable 'Auto Accept' for registrations in MyMedicare Preferences via PRODA. 

 

☐ Confirm who scans consent forms and completes MyMedicare registration in 
PRODA. 

 

☐ Regularly import registered patient lists into your CMS refer to guides 
 

       

 

Best Practice    Medical Director 
  

Cubiko  

 

mailto:support@wentwest.com.au?subject=CCM%20and%20MyMedicare%20support%20request
https://help.pencs.com.au/display/CG/Data+Cleansing
https://help.pencs.com.au/display/CR/Identify%2Bactive%2Bpatients%2Bwith%2Bat%2Bleast%2B3%2Bvisits%2Bin%2Bthe%2Blast%2B2%2Byears
https://www.servicesaustralia.gov.au/how-to-register-for-individual-proda-account?context=33786
https://www.servicesaustralia.gov.au/managing-members-and-delegations-organisation-proda?context=33786
https://www.servicesaustralia.gov.au/hpos
https://wentwest.com.au/health-professionals/programs-and-priorities/digital-health/mymedicare/
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Upcoming%20changes%20to%20the%20MBS%20Chronic%20Disease%20Management%20Framework
https://westernsydney.communityhealthpathways.org/13454.htm
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20%E2%80%93%20Referral%20Arrangements%20for%20Allied%20Health%20Services.PDF
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/650f3eec0dfb990fca25692100069854/35bc9280594efa33ca258c9200126149/$FILE/PDF%20Version%20-%20Upcoming%20Changes%20to%20Chronic%20Disease%20Management%20Framework%20%E2%80%93%20Referral%20Arrangements%20for%20Allied%20Health%20Services.PDF
https://www.health.gov.au/resources/publications/mymedicare-community-information-kit?language=en
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://www.emphn.org.au/images/uploads/files/PRODA-Guide-Updating-MyMedicare-Preferences-to-enable-Auto-Accept-of-patient-led-registrations.pdf
https://kb.bpsoftware.net/bppremier/Spectra/Integrations/MyMedHPOSCSVImport.htm
https://wentwest.com.au/wp-content/uploads/2025/05/Medical-Director-identify-and-flagging-patient-for-mymedicare.pdf
https://wentwest.com.au/wp-content/uploads/2025/05/Medical-Director-identify-and-flagging-patient-for-mymedicare.pdf
https://www.cubiko.com.au/gpccmp
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☐ Monitor de-registrations via HPOS – refer activity Management registration via 
HPOS 

 
 

 

Step 5 ACTIONS Assigned to 

Patient 
Identification 
& Recall 

☐ Use CAT4 to to identify eligible patients (chronic condition + MBS eligibility)   

☐ Offer GPCCMP plans opportunistically (during consults, HA’s, immunisations)  

☐ Recall existing CDM patients to update them to GPCCMP  

☐ Support clinicians with referrals, scripts, and bookings  

☐ Set automated reminders (BP/MD, Hotdoc, AutoMed, Healthengine)  

☐ establish / review your process for booking reviews & managing missed 
appointments 

 

 

Step 6 ACTIONS Assigned to  

Monitor, 
Reflect, and 
Celebrate 

☐ Use QI tools to track CCM transition activities (e.g., PDSAs, data reviews)  

☐ Monitor registration targets and plan review timelines  

☐ Regularly review and update all documentation  

☐ Review your video telehealth setup for MyMedicare (consider using -create a 
Healthdirect account or login) 

 

☐  Celebrate milestones and successes with your team  
Adapted from: Brisbane North PHN and West Vic PHN 

 

 

 

 

The infographic below depicts an example of management planning for a chronic condition patient. Review 

appointments as clinically relevant support ongoing patient engagement and care continuity.  

   

Do a PDSA - Team 

awareness, desire and 

readiness 

https://www.healthdirect.gov.au/video-call-reg
https://vcc.healthdirect.org.au/login
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1.2 Activity – Preparing your practice for CCM QI Action 

A systematic approach to defining team roles, engaging patients, and quality improvement is necessary for 

successful Chronic Condition Management (CCM).  

Every successful Quality Improvement starts with setting clear goals, underpinned by data and requires ongoing 

measurement and cycles of new activity in response to your findings. This process engages your primary health 

care team in assessing progress and tracking if change(s) are leading to an improvement. 

Demonstrating the impact of your team’s QI actions is essential to maintaining engagement, momentum and 

building a culture of celebrating success! 

It is best to measure at the beginning of the activity (baseline) and then at regular intervals. Use the Model for 

Improvement (MFI) framework to methodically work through identifying a clear problem, and to explore solutions 

and take action. 

The QI Activity Goal below is an example of a clear goal for Chronic Conditions Management and MyMedicare 

you could adapt to your practice. 

 

 

 

 

 

  

https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
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1.3 Activity – Communication Action Plan  

  

 

QI focus area 
Why improve 

this focus area? 
QI ideas 

“What” of the action plan 
Resources 

Practice name:  

MyMedicare 

Patient 

Registration  

To increase patient 

registration for 

MyMedicare for our 

General Practice    

 

What are the benefits of 

undertaking activities in this 

area? 

• Opportunity to formalise, 

establish or enhance our 

relationship for ongoing 

coordinated care with patients 

 

• To prepare for Chronic 

Conditions Management (CCM) 

MBS item changes 

 

• To prepare for changes to Better 

Access Mental Health Treatment 

Plans 

      

 

What ideas can we explore? 
 
Tips for engaging patients: 
• Encourage registration as they present to the 

practice or attend appointments including patient 

who have: 

• attended the practice twice in 24 months  

• attend the practice for ongoing care 

management (e.g. Chronic Disease 

Management Plans, Mental Health Treatment 

Plans, Health Assessments and Health 

Checks)  

Communication approaches/ideas 
• Posters or flyers - waiting room and reception 

• Website and/or social media   

• Targeted identification - Search and tag patient 
records for action when they present or contact the 
practice 

• Encourage patients to register through Medicare 
Online Account or Express Plus Medicare Mobile 
app 

• Conversations at appointments including reminder 
cards, information in clinic rooms. 

• SMS or email campaign 

• MyMedicare patient forms offered to patients (note- 
paper forms submitted through PRODA require 
additional staff time required to process) 

• Poster documenting your unique MyMedicare value 
or key messages 

Clinic resources 

1. MyMedicare GP Toolkit (includes 

posters, social tiles, flyers, etc) 

2. MyMedicare Videos 

3. Introducing MyMedicare – Fact sheet 

4. Registering in MyMedicare – Fact 

sheet 

5. MyMedicare practice registration – 

Frequently asked questions 

6. Registering patients with MyMedicare 

– Systems overview for practices and 

providers 

7. MyMedicare Program Guidelines  

8. About MyMedicare for health 

professionals  

https://www.health.gov.au/our-work/upcoming-changes-to-mbs-chronic-disease-management-arrangements
https://www.health.gov.au/our-work/upcoming-changes-to-mbs-chronic-disease-management-arrangements
https://www.health.gov.au/our-work/upcoming-changes-to-mbs-chronic-disease-management-arrangements
https://www.health.gov.au/resources/collections/resources-for-mymedicare-general-practices-and-healthcare-providers?language=en#brochures-and-posters
https://www.health.gov.au/resources/collections/resources-for-mymedicare-general-practices-and-healthcare-providers?language=en#gp-and-community-stakeholder-kit
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://www.health.gov.au/resources/publications/mymedicare-gp-toolkit?language=en
https://www.bing.com/videos/riverview/relatedvideo?&q=Mymedicare+eligibility&qpvt=Mymedicare+eligibility&mid=382C1030412A4D4645B3382C1030412A4D4645B3&mmscn=mtsc&aps=3&FORM=VRDGAR
https://www.health.gov.au/resources/publications/introducing-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/registering-in-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/registering-in-mymedicare-fact-sheet?language=en
https://www.health.gov.au/resources/publications/mymedicare-practice-registration-frequently-asked-questions?language=en
https://www.health.gov.au/resources/publications/mymedicare-practice-registration-frequently-asked-questions?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/webinars/registering-patients-with-mymedicare-systems-overview-for-practices-and-providers?language=en
https://www.health.gov.au/resources/publications/mymedicare-program-guidelines?language=en
https://www.servicesaustralia.gov.au/about-mymedicare-for-health-professionals?context=20#:~:text=To%20be%20eligible%20for%20MyMedicare%2C%20providers%20must%3A%201,or%20Department%20of%20Veterans%E2%80%99%20Affairs%20%28DVA%29%20equivalent%20services.
https://www.servicesaustralia.gov.au/about-mymedicare-for-health-professionals?context=20#:~:text=To%20be%20eligible%20for%20MyMedicare%2C%20providers%20must%3A%201,or%20Department%20of%20Veterans%E2%80%99%20Affairs%20%28DVA%29%20equivalent%20services.
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1.4 Activity – Practice Change (QI) Plan   

Please complete the following table to outline your plan to complete the goal. 

 

E
n

g
a

g
e

d
 

L
e

a
d

e
rs

h
ip

 Goal 
Improve chronic condition management by focusing on MyMedicare registration in [insert time frame] from ##% (## patients) to ##% (## patients) by 
DD/MM/YYYY.  

Measure/s 

• number of patients MyMedicare registered 

• number of patients on the chronic conditions register  

• number of management plans/reviews billed 

• number of appointments (missed, rebooked) 

Search criteria i.e. CAT4 filters 

QI Lead and Team Who will need to be involved? Period  Start date  -  end date 
 

 

 Actions  Tip: Use PDSA cycles to test change ideas Activity  Resources Who Period Update 

D
a

ta
-D

ri
v

e
n

 
Im

p
ro

v
e

m
e

n
t Conduct data cleansing to identify and verify patients with 

MyMedicare status and chronic conditions. 
 

• CAT4 Data Cleansing  

• Archiving BP |  MD  
 

Start date  -  
end date 

Allocated a usual care provider to 
patients 

Identify your MyMedicare and CCM patients using CAT4 and 
document baseline data 

 • CAT4 Chronic Conditions    

Find eligible patients that are due for management plan/ review   • CAT4 GPMP/TCA   Used TopBar prompt 

P
a

ti
e

n
t 

R
e

g
is

tr
a

ti
o

n
 Ensure recall and reminder system is established for 

MyMedicare and CCM patients 
 

• BP Reminder  

• MD Recalls 
  

Upskill staff in recalls and 
reminders TrainIT -Course  

Educate patients on CCM management plan and review benefits  • GoShare CCM video   Trained team on GoShare  

Communicate and promote MyMedicare and CCM      

T
e

a
m

-B
a

s
e

d
 

C
a

re
 

Identify roles and responsibilities      

Map workflows and upskill team in MyMedicare and CCM      

Assign a nurse or admin staff to track and rebook missed 
appointment  

 • CAT4 |  BP | MD    

Train clinical staff to enter coded diagnoses (no free text)       

Ensure staff can access HealthPathways for the latest chronic 
conditions assessment, management and referral information 

 
• Western Sydney 

HealthPathways 
   

Create patient-centred goals with more frequent reviews  • CAT4 Physical activity    

R
e

fl
e

c
ti

o
n

 

Outcomes 
Summary 

As a team, what did you learn?  What changes would you make to your practice as a result? 

RACGP CPD Tip: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection. 

https://help.pencs.com.au/display/CG/Data+Cleansing
https://kb.bestpracticesoftware.com/bppremier/spectra/Utilities/Search/SearchDeactivatePatient.htm
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FFlagging_Patients_as_Inactive.htm&rhsearch=inactive&rhhlterm=inactive&rhsyns=%20
https://help.pencs.com.au/display/CG/Chronic+Disease
https://help.pencs.com.au/display/CG/MBS+Eligibility
https://kb.bestpracticesoftware.com/bppremier/spectra/Clinical/Reminders/ClinicalReminders.htm
https://kb.bestpracticesoftware.com/bppremier/spectra/Clinical/Reminders/ClinicalReminders.htm
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FAdding_and_Editing_Recalls.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://courses.trainitmedical.com.au/
https://courses.trainitmedical.com.au/
https://wentwestlimited.sharepoint.com/sites/PracticeDevelopment/Shared%20Documents/Practice%20Development%20-%20Internal/MyMedicare/9.%20CCM%20MBS%20reform/CCM%20toolkit/What%20is%20a%20Chronic%20Condition%20Management%20Plan?%20low-literacy%20video
https://goshare.realtimehealth.com/users/sign_in
https://help.pencs.com.au/pages/viewpage.action?pageId=1476496
https://kb.bestpracticesoftware.com/bppremier/spectra/Management/AppointmentBook/FindMoveCancel.htm
https://www.medicaldirector.com/help/index.htm#t%3Dtopics-clinical%2FReason_for_Contact.htm%26rhsearch%3Dconfidential
https://westernsydney.communityhealthpathways.org/
https://westernsydney.communityhealthpathways.org/
https://help.pencs.com.au/display/CG/Physical%2BActivity
https://help.pencs.com.au/display/CG/Physical%2BActivity
https://mycpd.racgp.org.au/log


 

CCM Toolkit -   ©   Western Sydney Primary Health Network – WentWest  

Printed copies of this document are uncontrolled. Version 2. 4 September 2025       12 

1.5 Activity – Practice Meeting template 

The most common way for practices to build teamwork is to schedule regular meetings  

where all members of the practice team are encouraged to contribute to discussions. It is a good idea to keep minutes 

of the meetings and to document the decisions made at team meetings and the names of those responsible for 

implementing related actions.  

A Practice Meeting needs between 2-25 participants (GPs, practice staff and other health professionals) with each 

meeting lasting at least 30mins, in order to meet CPD activity requirements.  

< Practice Meeting Title> 

Please note:  

• (C0.0►C, QI0.0A) is RACGP Standards for General Practices – 5th edition indicator 

• RACGP CPD type: Educational Activities (EA), Reviewing Performance (RP), Measuring Outcomes (MO) 
 

PRACTICE  Date:  

CHAIR  
(GP/Practice Lead) 

 Time:  

Participant names  

Agenda/ Topics Actions/ Summary – Example 
CPD Type / 
Duration 

1. Quality 
Improvement 
(QI1.1►B,C,D) 

• This can include updates on QI projects such as MyMedicare, Chronic 
Condition Management (CCM) change ideas, coming together to discuss 
changing current processes to improve data, staff feedback on anything 
relating to the practice.  

• Making quality improvements to the practice’s structures, systems and 
clinical care that are based on the practice’s information and data will 
lead to improvements in patient safety and care. 

Quality Improvement includes: 

• Patient health records quality 

• MyMedicare/CCM project changes to the day-to-day operations of the 
practice, such as – scheduling of appointments – normal opening hours 
– record-keeping practices – how patient complaints are handled – 
systems and processes 

• Responding to feedback or complaints from patients, carers or other 
relevant parties  

• Responding to feedback from members of the practice team  

• Auditing clinical databases  

• Analysing near misses and errors. 

• Practices –what QI is being implemented across the practice 
 
MyMedicare Practice Registration: 

• MyMedicare practice registration checklist here. 

• Adding GPs as providers to the Organisation Register in PRODA here.  

• Providing practice staff with relevant delegations to view and manage 
patient registration here. 

• Educating non-clinical staff on the steps involved in patient registration 
with your practice and preferred GP here. 

 
MyMedicare Patient Registration: 

• Patient facing resources to formalise the relationship between patient, 
general practice, and preferred GP here. 

• Patient eligibility and methods of registration here.  

• MyMedicare Patient Registration Form here. 
 
MyMedicare and CCM Examples meeting resources: 

• Patient registration benefits here. 

RP 30mins 

https://www.racgp.org.au/running-a-practice/practice-standards/standards-5th-edition/standards-for-general-practices-5th-ed/introduction-to-the-standards-for-general-practice/accreditation
https://hpe.servicesaustralia.gov.au/INFO/MYMED/MYMEDINFO1.pdf
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www.health.gov.au/resources/collections/resources-for-mymedicare-general-practices-and-healthcare-providers
https://www.health.gov.au/our-work/mymedicare/patients#how-to-register
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://wentwest.com.au/health-professionals/programs-and-priorities/digital-health/mymedicare/#:~:text=There%20are%20several%20benefits%20of,and%20D)%20for%20registered%20patients


 

CCM Toolkit -   ©   Western Sydney Primary Health Network – WentWest  

Printed copies of this document are uncontrolled. Version 2. 4 September 2025       13 

• MyMedicare General Practice Communication Toolkit here. 

• CCM MBS item changes – Overview here  

• CCM MBS item changes – Transition Arrangements for Existing 
Patients here  

• CCM MBS item changes – Referral Arrangements for Allied Health 
Services here 

• CCM MBS item changes – MBS Items for GP Chronic Condition 
Management Plans here 

 

2. Risk 
management 
including 
Clinical Risk  
(C3.1►C, 
QI3.1A) 

 

Have any staff identified any risks in the practice that should be addressed? If 
mentioned here, they should be placed in the risk register and addressed. 
Examples: 

o Poor record keeping  
o IT system failures  
o Inadequate systems for updating patients’ contact details and 

following up test results  
o Workplace health and safety incidents, as a result of equipment 

that is not maintained in accordance with the manufacturer’s 
recommendations  

o Inadequate number of practice staff working during busy times  
o Conflicts of interest/ethical dilemmas 
O Updates to or breaches of the IT security system. 

 

 

3. Patient 
Feedback 
(QI1.2►B) 

Depending if the practice collects feedback once every three years or on a 
continual basis will guide this agenda item. Either way this is a good time to 
address patient feedback and possibly ask the team if they have any solutions.  

 

 

4. WHS  
(C3.5►A) 

Raising issues about the health and safety of the team. For example, are duress 
alarms required, how to deal with an aggressive patient. 

 

 

5. Clinical Care of 
patient’s 
(C5.1►A,B) 

 

• When clinical teams discuss clinical care, they must refer to and consider 
the best available evidence, to ensure their clinical care aligns with best 
practice. In some instances, ‘best practice’ may involve doing more than 
adhering to current clinical guidelines. Each team meeting there could be 
a new clinical topic, such as referral for a colonoscopy where patient 
symptomatic and urgency of referral are discussed  

• Specific patient cases can also be discussed at team meetings if patient 
confidentiality is maintained. 

 

 

6. Other  
 

• Ethical dilemmas- These are then to be entered into an ethical dilemma 
log and the patient’s files- C2.1►E 

• Administrative matters- C3.4►A 

• Infection control updates including changes to guidelines and laws.  

• An opportunity to announce local outbreaks and public health alerts - 
GP4.1►A 

 

 

 
 
 

 
 

  

https://www.health.gov.au/resources/publications/mymedicare-community-information-kit?language=en
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520Framework%2520-%2520Overview.DOCX&wdOrigin=BROWSELINK
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520MBS%2520Items%2520%25E2%2580%2593%2520Transition%2520Arrangements%2520for%2520Existing%2520Patients.DOCX&wdOrigin=BROWSELINK
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520Framework%2520%25E2%2580%2593%2520Referral%2520Arrangements%2520for%2520Allied%2520Health%2520Services.DOCX&wdOrigin=BROWSELINK
https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.mbsonline.gov.au%2Finternet%2Fmbsonline%2Fpublishing.nsf%2F650f3eec0dfb990fca25692100069854%2F35bc9280594efa33ca258c9200126149%2F%24FILE%2FWord%2520Version%2520-%2520Upcoming%2520Changes%2520to%2520Chronic%2520Disease%2520Management%2520Framework%2520-%2520GPCCMPs.DOCX&wdOrigin=BROWSELINK
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Module 2 
Patient Registration & Engagement 
 On completion of this module, you will: 

• Enhance communication strategies to boost patient participation in MyMedicare and CCM. 

• Develop effective systems for timely care plan review reminder 

• Design resources that educate and encourage active involvement in care planning and review 

 
 

Person-centred care is the foundation of both CCM and MyMedicare 

At the heart of both MyMedicare and Chronic Conditions Management (CCM) is person centred care—healthcare 

that aligns with each patient’s unique values, needs, and life goals. This approach strengthens engagement, 

supports continuity, and leads to better health outcomes. Core principles include:  

1. Dignity 

2. Compassion 

3. Coordinated  

4. Personalised Care 

5. Empowerment for Self-Management.  

Both initiatives promote active patient participation and shared decision-making, moving away from one-size-fits-

all models to deliver care that is truly tailored to the individual. 

We support practices in delivering person-centred care through programs like our Patient Centred Medical Home 

(PCMH) and MyMedicare. These initiatives strengthen connections between patients, their GPs, and care teams 

while emphasising accessibility, coordination, and quality. 

 

 
 MyMedicare Patient Registration: 

1. Medicare Express Plus mobile App  

2. Medicare online - MyGov Account  

3. Paper registration form, submitted in person 

at our practice. You can pre-fill MyMedicare 

forms - Refer to Activity  

 
Tip: Enable 'Auto Accept' for patient registrations in 
MyMedicare Preferences via PRODA and pre-fill  
 
Learn more  

• Managing MyMedicare registrations – 
eLearning  

• Our MyMedicare Patient Registration Guide 
• Our MyMedicare One Page Patient Guide 

 

 

 

Patient Resources:  

• MyMedicare - DL Brochure 
• MyMedicare - Easy Read Brochure 
• MyMedicare - Poster 1 
• MyMedicare - Poster 2 
• MyMedicare - Poster First Nations 
• MyMedicare - Community Information kit 
• Introducing MyMedicare Video 
• Registering in MyMedicare Video 
• MyMedicare - Social Media Tile 

 

This often begins by asking "What matters to you?" rather 

than "What is the matter with you?" to better understand and 

incorporate the patient’s life goals into care planning. It 

fosters greater patient engagement in the care planning 

process and supports tailored, meaningful care. 

 

https://www.health.gov.au/our-work/mymedicare/about
https://wentwest.com.au/health-professionals/programs-and-priorities/patient-centred-medical-home/
https://wentwest.com.au/health-professionals/programs-and-priorities/patient-centred-medical-home/
https://wentwest.com.au/health-professionals/programs-and-priorities/digital-health/mymedicare/
https://www.servicesaustralia.gov.au/express-plus-medicare-mobile-app
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.health.gov.au/resources/publications/mymedicare-registration-form?language=en
https://www.emphn.org.au/images/uploads/files/PRODA-Guide-Updating-MyMedicare-Preferences-to-enable-Auto-Accept-of-patient-led-registrations.pdf
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://wentwest.com.au/wp-content/uploads/2023/11/MyMedicare-Patient-Registration-Guide.pdf
https://wentwest.com.au/wp-content/uploads/MyMedicare/6.-WW-MyMedicare-Patient-Registration-One-Pager.pdf
https://www.health.gov.au/sites/default/files/2023-09/mymedicare-dl-brochure.pdf
https://www.health.gov.au/resources/publications/mymedicare-what-it-is-and-how-to-sign-up-easy-read?language=en
https://www.health.gov.au/resources/publications/mymedicare-poster-1?language=en
https://www.health.gov.au/resources/publications/mymedicare-poster-2?language=en
https://www.health.gov.au/resources/publications/mymedicare-poster-first-nations?language=en
https://www.health.gov.au/resources/publications/mymedicare-community-information-kit?language=en
https://www.health.gov.au/resources/videos/introducing-mymedicare?language=en
https://www.health.gov.au/resources/videos/registering-in-mymedicare?language=en
https://www.health.gov.au/resources/publications/mymedicare-social-tiles?language=en
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2.1 Activity – Reminders, Registration and Flagging 

This activity helps practices implement or enhance reminder and recall systems to  

improve MyMedicare registration, support care planning, and ensure timely reviews for patients with chronic 

conditions. By leveraging your clinical software, you can: 

• Proactively identify and flag eligible patients 

• Pre-fill MyMedicare registration forms (RTF) 

for individual patients or bulk print them using mail merge 

• Automate communication and reminders 

• Improve data accuracy and patient engagement 

This enables smoother registration, better continuity of care, and future-ready 

MBS claiming.  

The following steps and screenshots show how to register and flag patients in Best Practice, Medical Director, 

and My Health Record. 

Software-Based Instructions 

Best Practice (BP) 

BP Spectra will compass all CCM changes 
including database searches, printable guides 
and desktop foldout resources 

• Use MyMedicare Awareness and BP Comms 
to reach eligible patients 

• Use BP database queries to identify eligible 
patients  

• Tools: 
o Reminder   
o Actions 
o Mail merge   
o SMS reminders  

    WentWest’s Best Practice Guide for MyMedicare 

  BP MyMedicare | www.bpsoftware.net  

   1300 40 1111 
 

Medical Director (MD) and Pracsoft 

• Use Telstra Health Smart Visual Dashboards  
to identify eligible patients, Track MyMedicare 
registrations, Send SMS reminders  

• Tools: 
o Reminders 
o Actions 
o Mail merge 
o SMS reminders 

• Resources 

     WentWest’s Medical Director Guide for MyMedicare 

  MD MyMedicare | www.medicaldirector.com   

   1300300161 

 

 

Cubiko (for BP/MD users) 

• GPCCMP home  
o Cubiko Insights - GPCCMP metrics 

and forecasting dashboard 
o Cubiko Insights: CCM Preparation: 

Actionable metrics My Dashboard 

• Resource pack including staff room poster, 
patient handout, flyer and printouts 

• Identify and flag MyMedicare eligible 
patients  

• Export/import CSV lists for targeted 
outreach  

 

     WentWest’s Cubiko Guide for MyMedicare 

  Cubiko Knowledgebase  

   1300 CUBIKO  
 

 

Other Reminder Systems 

The following platforms can also be used 
independently or in conjunction with your clinical 
software to manage patient recalls and reminders: 
 

o Pracsoft 

o Hotdoc 

o Healthengine 

o AutoMed 

 

Note: WentWest does not provide software licensing for these systems.   

  

Patients can then register 

using these pre-filled 

paper forms or via the 

Medicare Online 

Account or Express Plus 

Medicare Mobile app 

https://kb.bestpracticesoftware.com/docs/qrg/BpPremier_QRG_GPChronicConditionManagementPlans.pdf
https://kb.bestpracticesoftware.com/docs/qrg/BpPremier_PrintableFoldout_CDMChangesJuly2025.pdf
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMBpComms.htm
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMPatients.htm
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMPatients.htm
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendClinicalReminders.htm
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/PatientRecord/Actions.htm?Highlight=actions
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendHealthAwareness.htm?Highlight=send%20health%20awareness
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendClinicalReminders.htm?Highlight=Send%20clinical%20reminders
https://wentwest.com.au/wp-content/uploads/2025/05/Best-Practice-identify-and-flagging-patient-for-mymedicare.pdf
https://kb.bpsoftware.net/bppremier/Orchid/MedicareDVA/MyMedicareHome.htm
https://www.bpsoftware.net/
https://www.medicaldirector.com/news/practice-management/improve-health-practice-efficiency-with-sms/?utm_campaign=%27While%20You%20Were%20Practising%27&utm_source=hs_email&utm_medium=email&_hsenc=p2ANqtz-_pq7fR-x94fAdv3otqCIdZeoYPNMWunJntQUMjAZ-M1-UgudzsbIGcw7TzLWhiNxR5PF2u
https://www.medicaldirector.com/help/index.htm?#t=kba%2Fclinical%2FRecalls%2C_Reminders%2C_Actions%2C_and_Outstanding_Requests_-_Fact_Sheet.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://www.medicaldirector.com/help/index.htm?#t=topics-clinical%2FAbout_Recalls%2C_Recall_Actions_and_Outstanding_Actions.htm&rhsearch=mymedicare
https://www.medicaldirector.com/help/#t=topics-clinical%2FMail_Merge.htm&rhsearch=mail%20merge&rhsyns=%20&rhhlterm=mail%20merge
https://www.medicaldirector.com/help/#t=topics-clinical%2FSending_SMS_Reminders.htm&rhsearch=sms&rhsyns=%20
https://wentwest.com.au/wp-content/uploads/2025/05/Medical-Director-identify-and-flagging-patient-for-mymedicare.pdf
https://www.medicaldirector.com/news/practice-management/mymedicare-administration-in-medicaldirector-your-essential-guide/
http://www.medicaldirector.com/
https://www.cubiko.com.au/GPCCMP/
https://www.cubiko.com.au/features/ccm/
https://app.cubiko.com.au/app/dashboards/template/632e2016-a111-4788-9fd2-08632c86061a
https://www.cubiko.com.au/resources/chronic-condition-management-resource-pack/
https://kb.cubiko.com.au/en/mymedicare-eligible-patients-with-an-appointment-today
https://kb.cubiko.com.au/en/mymedicare-eligible-patients-with-an-appointment-today
https://kb.cubiko.com.au/en/mymedicare-csv-export-import
https://wentwest.com.au/wp-content/uploads/2025/05/Cubiko-identify-and-flagging-patient-for-mymedicare.pdf
https://kb.cubiko.com.au/en/cubiko-knowledge-base#mymedicare
https://www.medicaldirector.com/help/index.htm?#t=shared-content%2FStart_Pracsoft.htm
https://practices.hotdoc.com.au/
https://practices.healthengine.com.au/blog/heres-your-support-team-tip-reminders-plus/
https://automedsystems.com.au/automed-sms-appt-reminders-dna/
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.servicesaustralia.gov.au/medicare-online-account
https://www.servicesaustralia.gov.au/express-plus-medicare-mobile-app
https://www.servicesaustralia.gov.au/express-plus-medicare-mobile-app
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2.1.1 Management registration via HPOS 

To support your team, access the Services Australia MyMedicare eLearning  

modules for MyMedicare overview and Managing patient registration 

Accessing the Patient List in HPOS >MyMedicare program 
 

1. Log in to PRODA to use HPOS → Select the organisation to act on behalf of. 

 

2. My Programs → MyMedicare 

 

3. Go to Patient List 

 

 

 

 

 

 

Viewing Withdrawn or De-registered Patients 

4. In the Patient List, use the Search Criteria filters   

 

5. Tick “Withdrawn registrations” to include de-registered patients.  

6. Look under the “Date Withdrawn” column to see when deregistration occurred.  

 

Exporting Patient Records 

7. Click Export Complete Registrations List to download both Complete and Pending lists).  Use this list to 

track deregistered patients and take follow-up action 

 

  

Tip: If “MyMedicare” 

doesn’t appear, your 

PRODA access may 

need updating. 

 

https://hpe.servicesaustralia.gov.au/mymedicare.html
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM01/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www2.medicareaustralia.gov.au:5447/sso/sps/oidc/rp/HPOSWEB/kickoff/proda1
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Managing MyMedicare via HPOS Mail Centre 
 

1. Log in to PRODA to use HPOS → Select the organisation to act on behalf of. 

2. Go to Messages → My organisation(s) mailbox. 

3. Select Settings → Choose your email and notification frequency (immediate, daily, weekly)  

4. Click Submit. 

Here’s an example of MyMedicare Patient registration activities 

 

Individual patient  

 
1. Log in to PRODA to use HPOS → Select the organisation to act on behalf of → My Programs → 

MyMedicare 

2. Go to Register a patient → Find a patient  

3. Enter details:  Medicare/DVA CARD number, IRN, First name, DOB → tick declaration → click Find 

4. Select patient → Register for MyMedicare 

5. Choose: Practice (Organisation site) → Preferred GP 

6. Confirm eligibility (auto or select reason) 

7. Review details → tick declaration → click Confirm 

8. For pending registration: choose "Pending" instead of "Complete" on step 4. 

If the patient is registered with another practice, this message will appear:

https://www2.medicareaustralia.gov.au:5447/sso/sps/oidc/rp/HPOSWEB/kickoff/proda1
https://www2.medicareaustralia.gov.au:5447/sso/sps/oidc/rp/HPOSWEB/kickoff/proda1
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Bulk import option of MyMedicare: Download exported registration list from HPOS for patient registration status and import list using Bp Premier 
Reporting Tool for full details include HPOS screenshots – refer to WentWest’s Best Practice Guide for MyMedicare 

 

2.1.2 Best Practice – CCM, MyMedicare Registration and flagging  
 

For the latest updates, visit BP Premier Spectra including MyMedicare Medicare Web services (enrolment management and registration check)  

new templates (GPCCMP and CCMP AHP referral), appointment types, SQL queries and Co-billing logic. 

 

MyMedicare Registration Form via Letter writer  

Letter writer (RTF format) will auto-populate with patient details  
ready for patient to provide sign consent.  
 
File→ New Letter (F4) → Templates→ Use Template→ Open 
 

 

Flagging MyMedicare registered status 

MyMedicare Registered status will be displayed on: 
 

Patient Record  
 

Appointment book 
 

 
 

Invoices 
 

 

Individual Patient Registration 

File → Open Patient → View → Patient/F2 → View details →  
Complete the fields listed below → Save  

 

  

https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyMedHPOSCSVImport.htm?Highlight=bulk%20import%20mymedicare
https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyMedHPOSCSVImport.htm?Highlight=bulk%20import%20mymedicare
https://wentwest.com.au/wp-content/uploads/2025/05/Best-Practice-identify-and-flagging-patient-for-mymedicare.pdf
https://kb.bestpracticesoftware.com/bppremier/spectra/Clinical/EPC/GPCCMP.htm
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2.1.3 Best Practice - My Health Record & MyMedicare Registration 

 

Retrieve MyMedicare Documents from My Health Record. MyMedicare information is sourced from Medicare systems operated by Services Australia and includes the 

patient's Registration date, Practice Name, Practice Address, and preferred GP name, if supplied. 

File → Open Patient, View→ Patient/F2→ My Health Record → View Document List → Filters →  
untick the Exclude Medicare documents and Exclude prescription and dispense records →  
Update → select MyMedicare Registered Practice information document → Open 
 

 

 

 

To access My Health Record, your staff 
 

• must have an HPI-I (identifies individual 

healthcare providers) To obtained via AHPRA 

account or by calling 1300 419 495, while non-

AHPRA staff can apply through HPOS. 
 

• Set User permissions: Best Practice main screen 

> Setup > Users > select employee > Edit > Set 

Permissions > scroll to My Health Record Access 

> Select ‘Allowed’ > Save. 

 

Please note the My Health Record participation 

obligations and Security and Access policies – Rule 42 

guidance. 

 

 

 

Save a Document to a Patient Record 
Please note patent preference to save this document  - See Understanding confidentiality and patient notes for more information. 

https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyHealthRecord/MyMedicareDocRetrieval.htm
https://www.ahpra.gov.au/Registration/Registers-of-Practitioners.aspx
https://www.servicesaustralia.gov.au/registering-to-use-healthcare-identifiers-hi-service-for-individual-healthcare-providers
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/PatientRecord/Confidentiality.htm
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2.1.4 Medical Director – MyMedicare Registration and flagging 

MyMedicare Registration Form via Letter writer  

Letter writer (RTF format) will auto-populate with patient details  
ready for patient to provide sign consent.  

Patient File → Tools → Letter Writer (F8) or  → File → New → Ok 
 

  

 

Individual Patient Registration 

File → Open Patient → View details →tick “This patient is registered with this 
Practice for MyMedicare” → select Preferred GP = “Regular Practitioner” → Save 
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2.1.5 Medical Director - My Health Record & MyMedicare Registration 

Retrieve MyMedicare Documents from My Health Record. MyMedicare information is  

sourced from Medicare systems operated by Services Australia and includes the patient's  

Registration date, Practice Name, Practice Address, and preferred GP name, if supplied 

Patient File→ My Health Record (or view document list) 

 

To access My Health Record, your staff 
 

• must have an HPI-I (identifies individual 

healthcare providers) To obtained via AHPRA 

account or by calling 1300 419 495, while non-

AHPRA staff can apply through HPOS. 
 

• Set User permissions: Medical Director main 

screen > Users > Setup Users > select employee > 

Edit > Tick box ‘Participate in MyHealthRecord’ > 

Ok. 

 

Please note the My Health Record participation 

obligations and Security and Access policies – Rule 42 

guidance. 

 

Save a Document to a Patient Record 
Please note patent preference to save this document  - See Understanding confidentiality and patient notes for more information. 

https://kb.bpsoftware.net/bppremier/Orchid/Integrations/MyHealthRecord/MyMedicareDocRetrieval.htm
https://www.ahpra.gov.au/Registration/Registers-of-Practitioners.aspx
https://www.servicesaustralia.gov.au/registering-to-use-healthcare-identifiers-hi-service-for-individual-healthcare-providers
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record/register-and-set-up-access/participation-obligations
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://www.oaic.gov.au/privacy/privacy-guidance-for-organisations-and-government-agencies/health-service-providers/my-health-record/Security-and-Access-policies-Rule-42-guidance
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/PatientRecord/Confidentiality.htm
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2.2 Activity – Scripts: phone, SMS, email, and website 

Please tailor scripts for phone, SMS, email, and website for staff to use when  
communicating with patients about Chronic Condition Management Plans and MyMedicare. 

📞 Phone Script  
(Reception or Nurse Call) 
 
Hi, this is [Your Name] from 
[Practice Name]. I’m just checking 
in about your ongoing care. 

If you have a health condition that 
lasts six months or more, you may 
be eligible for a Care Plan. This 
supports your health with a clear 
plan, plus up to 5 subsidised visits 
per year to allied health providers 
like a physio or dietitian. 

We also recommend registering for 
MyMedicare, which helps us 
provide more coordinated care. 

Would you like to book a longer 
appointment to get started or get 
more info? 

 

📱 SMS Script 

 

Hi [First Name], you may be eligible 
for a Care Plan and MyMedicare 
registration with your GP at 
[Practice Name]. 

This can support your ongoing care 
and give access to subsidised 
allied health visits. 

Call [Phone] or book online: 
[Website] 

 

📧 Email Script 

 

Subject: Care Plan & MyMedicare – 
Supporting Your Health 

 
Hi [First Name], 
If you have a long-term health 
condition, you may benefit from a 
Care Plan at [Practice Name]. It 
helps you and your GP plan and 
manage your care, and may include 
up to 5 subsidised allied health 
visits per year. 
We also recommend registering 
with MyMedicare to make sure your 
care is continuous and well-
coordinated. 

🕑 A longer appointment is needed 
to set up your plan. 

📅 You’ll check in with your GP 
every 3–6 months. 
Reply to this email, call us on 
[Phone], or book online at [Website] 

 

🌐 Website Text  
(Info Page or Pop-up) 

Do you have a long-term health 
condition? 

 
We can help you manage it with a 
Care Plan at [Practice Name]. This 
includes: 

o Your health goals 
o How we’ll support you 
o Up to 5 Medicare-

subsidised visits to allied 
health providers 

We also recommend registering for 
MyMedicare, a free program that 
links you to us as your regular 
practice — for more coordinated 
care. 

🕑 Longer appointments are 
needed to set up your plan 

📅 You’ll check in with your GP 
every 3–6 months 

👉 Ask us today, or [Book Online 
Now] 

 

 

 

Do a PDSA - Reducing 

Missed Appointments 

for Care Plan reviews 

Keep it clear, 

professional, and 

actionable. 
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2.3 Activity – GoShare Patient Engagement Platform  
 

 

 

Q
u
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For Best Practice (BP) Users 
Using GoShare BP PSI Integration 

All Users – Web-Based 
Using GoShare Portal 

For Medical Director /Zedmed Users 
Using CAT4 & GoShare Plus 

 
1. Install & Access:  

•  Ensure GoShare PSI is installed and    
activated in Best Practice. GoShare PSI 
download instructions 

• Log into GoShare PSI. 
 

2. Create Campaign 
Choose eligible patients by selecting a pre-built 
query from the GoShare PSI library. 

• Diagnosed with chronic condition 

• Not registered for MyMedicare 
 

3. Send Bundle 

• Choose SMS or email delivery. 

• Review and send to patients (you can 
stagger the sending in batches). 

 

 
1. Log In: https://goshare.realtimehealth.com 

 
2. Build a Bundle 

• Find MyMedicare or CCM resources (videos, 
fact sheets). 

• Click “Add to bundle”, then ★ (star icon) to 
save. 
 

3. Send to Patients 

• Click “Send bundle to list”. 

• Download CSV template. 

• Populate with patient details (Name, Phone, 
Email). 

• Upload, review, and send. 

• Direct Sends (Optional). 

• Click “Send bundle” → “New Recipient” → 
enter details → “Done”. 

1. Extract Patient Lis  

• Open CAT4, apply filters: 
i. ≥2 visits in 24 months 
ii. Chronic conditions 

iii. Not registered for MyMedicare 

• Export selected patient list as CSV file. 
 

2. Upload to GoShare Plus 

• Log into GoShare Plus. 

• Select MyMedicare or CCM bundle. 

• Upload CSV via “Send bundle to list”. 

• Match fields and send via SMS or email. 

• Follow Up. 
  

GoShare is a free* patient education platform enabling health professionals to send tailored, 

trusted resources—such as videos and fact sheets—via email or SMS to help patients manage 

their health, improve health literacy, and boost engagement.  

NEW! Use the What is a Chronic Condition Management Plan? low-literacy video to help explain 

recent CCM changes and the importance of regular reviews to your patients. You can also use 

the MyMedicare bundle — an all-in-one resource to increase awareness about the benefits of 

registering with your practice. 

To get started or request access, please contact our team support@wentwest.com.au 

*Free access provided through WentWest for general practices in Western Sydney. 

https://kb.healthily.com.au/knowledgebase/gspsiinstall/
https://kb.healthily.com.au/knowledgebase/gspsiinstall/
https://goshare.realtimehealth.com/
https://kb.healthily.com.au/knowledgebase/what-is-goshare/
https://kb.healthily.com.au/knowledgebase/patient-engagement-tips/
../../../Quality%20Improvement/What%20is%20a%20Chronic%20Condition%20Management%20Plan?%20low-literacy%20video
https://goshare.realtimehealth.com/users/sign_in
mailto:support@wentwest.com.au
https://goshare.realtimehealth.com/conditions/409/content_modules/215/animations/1636
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2.4 Activity – Check the number of allied health service  

1. Download and sign into Medicare Express Plus App or Medicare via MyGov  

2. Go to ‘Menu’ and select ‘My Care Plans’ 

3. Select ‘View history’. If multiple patients appear, choose the relevant name 

4. View Service claimed, including the number of Allied health visits claimed and provider details  

 

3. 

 

2. 

1. 

4 

 

Note: you can also 

download history (PDF) 

and when someone has 

accessed the care plans. 

https://www.servicesaustralia.gov.au/express-plus-medicare-mobile-app
https://login.my.gov.au/las/mygov-login?execution=e2s1
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Module 3 
Data-Driven Improvement 
On completion of this module, you will: 

• Use CAT4 – Mastering MyMedicare to drive proactive care. All activities in this module use CAT4 clinical 
searches and recipes to help identify, segment, and manage cohorts of patients for MyMedicare 
registration and chronic condition management. 

• Apply data-driven strategies to plan, implement, and review quality improvement (QI) activities. 

 

 

          RACGP  

Clinical Audit 

 

 

 

 

Before You Begin 

☐ Ensure CAT4 is installed and staff are trained to use Pen CS tools – use CAT4 guide or videos  

☐ Clean your data using CAT4 Data Cleansing (e.g. archive inactive records, remove duplicates). 

☐ Standardise coding: ensure diagnoses are coded, not free text – use CAT4 condition mapping 

☐ Filter by doctor, condition, or age to create a smaller patient list. 
 

 

Activities Navigation using CAT4 

3.1 Activity – MyMedicare patients 
3.2 Activity – Patients not registered with MyMedicare 
3.3 Activity – All CCM Patients due for a care plan and reviews  
3.4 Activity – Patients with a chronic condition eligible for care plan or review 
3.5 Activity – Patients with risk of hospitalisation eligible for care plan or review  
3.6 Activity – Filter by assign provider 
3.7 Activity – Create a prompt to display in Topbar 

 
 

Track & Reflect 

☐ Download the audit worksheet or run chart template 

☐ Record your baseline and follow-up data 

☐ Reflect with your team: What worked? What didn’t? 

☐ Completed QI documentation for CPD  

  

CPD Outcomes 
  Reviewing Performance (RP)     Measuring Outcomes (MO) 
 

      4 hours 6 hours 

WentWest offers a free, CPD-accredited Clinical Audit activity to help practices 

increase MyMedicare registration for patients with complex health needs. This 

supports proactive, data-informed care aligned with the 2025 CCM item changes. 

https://wentwest.com.au/wp-content/uploads/2025/05/CAT4-Mastering-MyMedicare.pdf
https://help.pencs.com.au/display/CR/How+to+get+started+with+CAT4+Recipes
https://vimeo.com/showcase/5501750
https://help.pencs.com.au/display/CG/Data+Cleansing
https://help.pencs.com.au/display/ADM/Data+Mapping
http://help.pencs.com.au/display/CR/Identify%2Bpatients%2Bseen%2Bby%2Ba%2Bparticular%2Bprovider%2Bor%2Bgroup%2Bof%2Bproviders
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3.1 Activity – MyMedicare patients 

       Activity Goal: Identify patients who are MyMedicare registered at your practice.  

➢ Starting point:  Log into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  
 
➢ In Filter Panel 

 
1. Under ‘Patient Status’ tab → tick ‘Registered with MyMedicare’ 

 

2. Recalculate  
 

3. View Population                
 

 

4. Optional: Select Export →   XLS File → Save (e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

 
5. Optional:  filter patient list by provider or 

 
6. Optional:  create a Topbar prompt 

 

  

https://help.pencs.com.au/display/CG/Navigating+CAT4
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3.2 Activity – Patients not registered with MyMedicare  

       Activity Goal: Identify patients who may be eligible for Voluntary Patient Registration  
at a general practice, based on having had at least two face-to-face visits in the past two years or who are active 
based on RACGP definition of 3 visits in the past 2 years. Optionally, exclude patients without a Medicare card. 
 
➢ Starting point:  Log into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  
 
➢ In Filter Panel 
1. Choose from the following two options to identify patients by active status or number of visits  

Optional 1: Under ‘General’ tab → Activity → Select ‘Active (3 x in 2 yrs)’  

 
Optional 2: Under ‘Visits’ tab → Select “≤24 mths” → “Number of Visits” box and enter 

“minimum: 2 and maximum: 999” 

 
2. Optional: Under ‘General’ tab select ‘Medicare No.’ 
 

3. Under ‘Patient Status’ tab → untick ‘Registered with MyMedicare’ 
 

4. Recalculate   

 

5. View Population 

 

6. Optional: Select Export →   XLS File → Save (e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

 

7. Optional:  filter patient list by provider or 

 

8. Optional:  create a Topbar prompt 

 

 

  

 

 

 

 

 

Do a PDSA – 

Identifying Active 

Patients & Linking to 

MyMedicare Program 

https://help.pencs.com.au/display/CG/Navigating+CAT4
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3.3 Activity – All CCM Patients due for a care plan and reviews  

       Activity Goal: Enhance care plan delivery for MyMedicare-enrolled patients  

managing chronic conditions. 

➢ Starting point: Log into Pen CS CAT4 → Show Extracts → load latest data extract → Hide Extract  

 

➢ In Filter Panel 
1. MyMedicare patient filter (Choose either MyMedicare enrolled or Not (Yet) 

enrolled): 

A. Under ‘Patient Status’ tab → tick ‘Registered with MyMedicare’ 

 

B. Under ‘Patient Status’ tab → untick ‘Not Registered with MyMedicare, and 
then follow the steps 

▪ Optional 1: Under ‘General’ tab → Activity → Select ‘Active (3 x in 2 yrs)’  

▪ Optional 2: Under ‘Visits’ tab → Select “≤24 mths” → “Number of Visits” box and enter 

“minimum: 2 and maximum: 999”’ 

2. CCM MBS filter (restricts cohort to those who have not had a Care Plan / Review in last “x” period):  

 

Under ‘MBS Attendance’ → select ‘Any of selected’ → select ‘No’ to 721, 723 or 732 (and 965/967 after 1 July 

2025) 

 

Optional:  Under ‘MBS Attendance’ → select ‘Claim Date Range’ for example: 

o ‘≤12months’ (care plans not billed in the past 12 months) 

o ‘≤6 Months’ (care plans reviews not billed in the past 6 months) 

o Date Range (from – to): 11/3/25 – 11/6/25 (care plan reviews not billed in the past 3month) 

 

3. Recalculate  

 

➢ In Report Panel 

4. Under ‘Disease’ tab → ‘Select all’ → then exclude the following conditions: Other Musculoskeletal; Covid-19; 

Fracture; None of these. 

 

 

 

 

 

 

 

 

 
 
 

5. Optional: Select Export →   XLS File → Save (e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

6. Optional: reduce patients list by filtering by: Condition , Risk of hospitalisation or Assigned provider 

 

 

 

 

Do a PDSA – 

CCM and 

MyMedicare 

https://help.pencs.com.au/display/CG/Navigating+CAT4
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3.4 Activity – Patients with a chronic condition eligible for care plan or review 

       Activity Goal: Increase care plan completion for MyMedicare-registered patients with 

 a specific condition. As there are a range of conditions that could fall under this group, here are examples to help 

identify MyMedicare eligible patients within the diabetes cohort. 

➢ Starting point: Log into Pen CS CAT4 → Show Extracts → load latest data extract → Hide Extract  

 

➢ In Filter Panel 
 
 

1. MyMedicare patient filter (Choose either MyMedicare enrolled or Not (Yet) enrolled): 

A. Under ‘Patient Status’ tab → tick ‘Registered with MyMedicare’ 

 

B. Under ‘Patient Status’ tab → untick ‘Not Registered with MyMedicare, and then follow the steps 

▪ Optional 1: Under ‘General’ tab → Activity → Select ‘Active (3 x in 2 yrs)’  

▪ Optional 2: Under ‘Visits’ tab → Select “≤24 mths” → “Number of Visits” box and enter 

“minimum: 2 and maximum: 999”’ 

2. CCM MBS filter (restricts cohort to those who have not had a Care Plan / Review in last “x” period):  

 

Under ‘MBS Attendance’ → select ‘Any of selected’ → select ‘No’ to 721, 723 or 732 (and 965/967 after 1 July 

2025) 

 

Optional:  Under ‘MBS Attendance’ → select ‘Claim Date Range’ for example: 

o ‘≤12months’ (care plans not billed in the past 12 months) 

o ‘≤6 Months’ (care plans reviews not billed in the past 6 months) 

o Date Range (from – to): 11/3/25 – 11/6/25 (care plan reviews not billed in the past 3month) 

 

3. Under ‘Conditions’ → select ‘Diabetes - Yes’  

  
 

4. Recalculate  

 

5. View Population  
 

6. Optional: Select Export →   XLS File → Save (e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

 

7. Optional:  filter patient list by provider or 

 

8. Optional:  create a Topbar prompt 

 

 

  

 

 

 

Do a PDSA – 

CCM and 

MyMedicare 

https://help.pencs.com.au/display/CG/Navigating+CAT4
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3.5 Activity – Patients with risk of hospitalisation eligible for care plan or review  

       Activity Goal: Increase care plan completion for MyMedicare-registered patients with 

 high risk of hospitalisation within the next 12 months.   

The CAT – Risk of Hospitalisation report uses the CSIRO’s predictive risk stratification algorithm to identify patients 

in general practice at high risk of hospitalisation within the next 12 months, categorising them into six risk levels 

based on factors such as conditions, medications, pathology, and demographics. 

➢ In Filter Panel 
 
 

1. MyMedicare patient filter (Choose either MyMedicare enrolled or Not (Yet) enrolled): 

A. Under ‘Patient Status’ tab → tick ‘Registered with MyMedicare’ 

 

B. Under ‘Patient Status’ tab → untick ‘Not Registered with MyMedicare, and then follow the steps 

▪ Optional 1: Under ‘General’ tab → Activity → Select ‘Active (3 x in 2 yrs)’  

▪ Optional 2: Under ‘Visits’ tab → Select “≤24 mths” → “Number of Visits” box and enter 

“minimum: 2 and maximum: 999”’ 

2. CCM MBS filter (restricts cohort to those who have not had a Care Plan / Review in last “x” period):  

Under ‘MBS Attendance’ → select ‘Any of selected’ → select ‘No’ to 721, 723 or 732 (and 965/967 after 1 July 

2025) 

Optional:  Under ‘MBS Attendance’ → select ‘Claim Date Range’ for example: 

o ‘≤12months’ (care plans not billed in the past 12 months) 

o ‘≤6 Months’ (care plans reviews not billed in the past 6 months) 

o Date Range (from – to): 11/3/25 – 11/6/25 (care plan reviews not billed in the past 3month) 

 

3. Recalculate  

➢ In Report Panel 

4. Click the "Risk Stratification" tab.  

5. The report shows patients grouped into six risk levels. 

6. To view patients in a specific risk group, click percentage risk percentage (i.e. >40%) or the pie chart.  

 

7. Optional: Select Export →   XLS File → Save (e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp)  

 

 

 

https://help.pencs.com.au/display/CG/CSIRO+Risk+of+Hospitalisation+Report
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3.6 Activity – Filter by assign provider 

       Activity Goal: Identify the provider the patient has seen most often in the past 18 months, that they are eligible for 
MyMedicare, care plan or have a specific condition 
 
➢ Starting point:  Log into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  

 
➢ In Filter Panel 
 
1. MyMedicare patient filter (Choose either MyMedicare enrolled or Not (Yet) enrolled): 

C. Under ‘Patient Status’ tab → tick ‘Registered with MyMedicare’ 

 

D. Under ‘Patient Status’ tab → untick ‘Not Registered with MyMedicare, and then follow the steps 

▪ Optional 1: Under ‘General’ tab → Activity → Select ‘Active (3 x in 2 yrs)’  

▪ Optional 2: Under ‘Visits’ tab → Select “≤24 mths” → “Number of Visits” box and enter 

“minimum: 2 and maximum: 999”’ 

2. CCM MBS filter (restricts cohort to those who have not had a Care Plan / Review in last “x” period):  

Under ‘MBS Attendance’ → select ‘Any of selected’ → select ‘No’ to 721, 723 or 732 (and 965/967 after 1 July 

2025) 

Optional:  Under ‘MBS Attendance’ → select ‘Claim Date Range’ for example: 

o ‘≤12months’ (care plans not billed in the past 12 months) 

o ‘≤6 Months’ (care plans reviews not billed in the past 6 months) 

o Date Range (from – to): 11/3/25 – 11/6/25 (care plan reviews not billed in the past 3month) 

 

3. Recalculate  

 

➢ In Report Panel 
 

4. Under “Visits” → go to “Assigned Provider” → select provider/s or “Select All”  

 

5. Optional: Select Export →    XLS File → Save (e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

 

  

CPD Measuring 

Outcome Tip   

Work as a team to 

generate a CAT4 

list of patients per 

GP. 

 

 

 

https://help.pencs.com.au/display/CG/Navigating+CAT4
https://help.pencs.com.au/display/CG/Assigned+Provider:%20Assigned%20Provider
http://help.pencs.com.au/display/CR/Identify%2Bpatients%2Bseen%2Bby%2Ba%2Bparticular%2Bprovider%2Bor%2Bgroup%2Bof%2Bproviders
http://help.pencs.com.au/display/CR/Identify%2Bpatients%2Bseen%2Bby%2Ba%2Bparticular%2Bprovider%2Bor%2Bgroup%2Bof%2Bproviders
http://help.pencs.com.au/display/CR/Identify%2Bpatients%2Bseen%2Bby%2Ba%2Bparticular%2Bprovider%2Bor%2Bgroup%2Bof%2Bproviders
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3.7 Activity – Create a prompt to display in Topbar 

1. Open Daily View in CAT4. Ensure Topbar is installed and linked via Edit > Preferences > Topbar. 

 
2. Apply filters to display your target patient list. 

3. At the bottom of the Patient Details Report, select "Prompt at Consult – Topbar" and click "Go". 

 
4. Enter a clear, simple name for the prompt—this is what clinicians will see in Topbar. 

 

For more information, refer Using Topbar Prompts in Recipes 

Topbar Applications 

Full details for all Topbar apps can be found here 

1. Once a patient matches prompt criteria in the clinical system, the CAT Prompts 

App in Topbar displays a red-circle notification.  

2. Clicking the prompt reveals details like the reason by and relevant patient data.  

 

 
 

  
 

Waiting Room App  
Displays patients in the 
Waiting Room with 
missing data. 

• Reception use: 
Highlights missing 
demographics. 

• Clinical tab: Shows 
missing clinical/ 
accreditation items 
(e.g. allergies, 
smoking, risk 
factors) for 
updates needed for 
accreditation and 
PIP QI. 

Data Cleansing App 

• Displays missing 
demographic/clinical 
data and uncoded 
chronic conditions. 

• Helps clean free-text 
diagnoses and 
improve disease 
registers. 

• Designed for consult 
rooms; shows one 
patient at a time. 

MBS App 
Alerts users to 
potential MBS item 
eligibility, including 

• Health 
Assessments, 

• Chronic 
Conditions 
Cycles of Care, 

• Medication 
Reviews,  

• Care Plans 

• Care Plan 
reviews. 

CAT Plus Prompts 
Create custom alerts 
in CAT4 to display in 
Topbar when 
patients present, 
helping teams 
address care gaps, 
identify risks, and 
support QI efforts. 

Patient Health 
Summary 
Provides a quick 
overview of key health 
info (e.g. meds, 
allergies, history, risks) 
as required by RACGP 
5th Edition Standards—
accessible with one 
click. 
 

 

Learn how to use Topbar by clicking the image below to watch a beginner's video tutorial  

https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
https://help.pencs.com.au/display/TUG/Topbar+Apps+in+Detail
https://vimeo.com/850740844?turnstile=0.VJXCG3E34zq6uox_6KpEY2UCRytpWmpD5bwnCZpNZt5dLr2QGYEgaAMmQp1kC_pif-F6CQQ5wpUb-cK0BVxhCMCHVAi7epvdFnDQ006WUAJHbwzlekr0q9cUiHfqZsXsA7UCqN40Kn4Z4wKKclXs-GmFohS67Vt6xUE8W7-9RQGacTov01NEdUTltX75acnsimA2c98xn3ho_fYczdxZ1x9NEUPcEs3wvh3t9_QOAridn4FR_DclZvzu5wrKHzRkvW617wzSvD2_nlGEdJQ6hP7SQSQbELuo_nCWaX4f15yIdTXM8Q9qT5v_s7qVffj_T9PS4f7zn5EQt7k8BTkm_VXT_hkdb4vpv0XLTyT2e8VmMrQuAP5oa2fpoojV5hzUtZ8Kx_1BRmUEA1Q8qKvxSLdU44pvR0i2HjX2jq-pbrxgwHQWaP3cI8gn8Dke3lJDOhsPfdBznxE3WvXhzODto22aF6Oc5rPujs0GaAM0Hnxdnfu4B6XATOmRpB5-ByYPj_TrBfBUwKSnXnRAqYYlC_Gqr_ZejhpitF6HOiObvwztPg_QoR4j2YsJST3j30Y_0qYlZu6qnfy3ekwzWSFfctifgdw7b5OGwZP4n8Xd_b8fyIP5SPTtJBjF79yXo-BQES8wBr9uJqItGaLAvrS1EIDOKzTr4f0-c6GRADXsRjGGutu4bb9QlyWbdhL4TnxWzNx4IdLX1O7WqqeIPb-LpjSBs-ZN-y1Ha_lNu46D_YHCbrGGOGelWr1X_phIlJRgPv8V-QgyFwgjTy3T424cW6157xwYXpXlri8neS-SV2nDr8rxuRwAIC-Dl5FMmjXRimsHUCHo-2OVr6XdWz8zaj8c87zS5hTFBzEqd4rAEGw.DGtMUxnSz7iZXESg2cAw_A.51405cd14d1992789bb718a7c695d68e0e2ed46b719c112fd283108e7d5b75c9
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Module 4 
Business & Team Optimisation  
 

On completion of this module, you will: 

 Optimise care plan reviews to boost efficiency, outcomes and practice performance.  

 Allocate team tasks to ensure clarity and ownership of each member's role.  

 

From 1 July 2025, there will be a revised structure for items for chronic disease management. The changes simplify, 

streamline, and modernise the arrangements for health care professionals and patients. These changes primarily 

affect medical practitioners, however, allied health professionals providing MBS services should be aware of the 

changes to the plan and referral requirements. Transition arrangements will be in place for two years to ensure 

current patients don’t lose access to services. 

Items for GP management plans (229, 721, 92024, 92055), team care arrangements (230, 723, 92025, 92056) and 

reviews (233, 732, 92028, 92059) will cease and be replaced with a new streamlined GP chronic condition 

management plan (GPCCMP). Table below - Chronic Condition Management items commencing 1 July 2025.  

Name of Item  GP item 
number  

PMP item 
number  

Frequency of 
Claiming  

Fee 

Prepare a GP chronic condition 
management plan – face to face  

965   392  Every 12 months  
if clinically relevant 

GPs - $156.55 
PMPs - $125.30 

Prepare a GP chronic condition 
management plan - video  

92029   92060  Every 12 months  
if clinically relevant 

GPs - $156.55 
PMPs - $125.30 

Review a GP chronic condition 
management plan – face to face  

967   393   Every 3 months  
if clinically relevant 

GPs - $156.55 
PMPs - $125.30 

Review a GP chronic condition 
management plan – video  

92030   92061  Every 3 months i 
f clinically relevant 

GPs - $156.55 
PMPs - $125.30 

 

The purpose of this resource is to support General Practices to plan their delivery of care for patients with chronic 

conditions and provide examples of how to use MBS items to provide regular care and review for patients in line with 

the intent of the MBS items.  

 
This resource demonstrates the potential use of MBS items related to CCM, for a full explanation of each MBS item 

please go to MBS online. https://www.mbsonline.gov.au/  

 

 

 
Disclaimer: This resource outlines some examples of how General Practice can utilise CCM MBS Items and incorporate participation of other members of the care team, General Practices are advised that this resource does not cover every 
single scenario or possible structure for scheduling the CCM items. The General Practice or ACCHO model of care, and team structure will further inform the general practice on how the organisation/business may apply Chronic Condition 
Management.  General Practices are encouraged to ensure familiarity and adherence with the MBS. 
  

MBS ONLINE 

• Search for Item Number  

• Fact Sheets  

• Updates (XML Files) 

• MBS News 

ELIGIBILITY  
 
Ensure patient meets billing 
criteria.  
• HPOS MBS checker  
• My Health Record  

MORE INFORMATION 
 
• www.mbsonline.gov.au 
• Contact  

MBS 13 21 50 
askMBS@health.gov.au 

Refer WentWest MBS guide for the frequently used items including Care Planning and 

incentives This guide links item number to MBS criteria, descriptor and fact sheets. 

https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=965
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=392
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92029
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92060
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=967
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=393
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92030
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=92061
https://www.mbsonline.gov.au/
https://www9.health.gov.au/mbs/search.cfm
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/factsheet-current
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/downloads
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/news
https://www.servicesaustralia.gov.au/check-mbs-item-numbers?context=20
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record
http://www.mbsonline.gov.au/
mailto:askMBS@health.gov.au
https://bit.ly/4kSlNXe
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4.1 Activity – Business Optimisation for CCM 

The Chronic Conditions Management MBS changes support general practices to 

undertake proactive care planning, quarterly reviews, team-based follow-up and early intervention. General practices 

should consider, how best to support their chronic condition patients with self-management and care to improve 

outcomes for their chronic conditions whilst effectively claiming to optimise practice Medicare revenue.  

Approach  

As a practice or as a team (GP, practice nurse, AHP, NP 
etc.), determine the approach you will take to GPCCMP 
and optimising both patient outcomes and revenue. 
 
 Annual GPCCMP:   Developed and shared with the 

patient and care team. 
 Quarterly Reviews: Assess goals, progress, 

symptoms, and update care as clinically required. 
 Nurse/AHP Follow-up Services: Delivered up to 5 

times annually to reinforce care plans and patient 
actions.  

 
Nurses or AHP may provide support and follow up at the 
time of the management plan/ review appointment. 
 
Alternatively, an approach may be for the nurse or AHP 
to provide a follow up phone call and support/touch 
point with the patient to check in, confirm care plan 
goals, assist with allied health or any other referral 
pathways.  

 
Either option the nurse or AHP can claim the MBS item 
10997.  
   

Revenue of one patient,  
attending all review appointments 

 

Service 
Times 
per 
Year 

Annual 
amount 
billed per 
patient 

Annual 
amount 
billed per 
patient 

GPCCMP MBS  
965 or 92029 

1 $156.55 
 

GPCCMP 
Review MBS 
967 or 92030 

3 $469.65 
 

Nurse/ AHP 
follow up 10997  

3-5 $40.95 - 
65.25 

$667.15 - 
$691.45 

 

Why Review: 
 

 Use Care Planning Claiming workflow to explore 
care plan contents.  

 Care plan reviews enable timely adjustments to 
medications, referrals, and self-management 
strategies.  

 Ultimately, working in partnership with patients for 
better outcomes leads to reduced hospital 
admissions.  

 Working together, with your team and patient to 
provide planned care across a 12-month cycle of 
care, will have an improved revenue impact.  

 
Operational Tips 
 Examine practice data - know who your CCM 

patients are.  
 Determine a target - % of patients rebooked for 

review appointments (include missed appointments 
and DNAs)  

 Engage your patients so they are well informed and 
aware of the reason/s for their review appointment 
and what will happen at the next appointment.  

 Recall - utilise practice systems to automate 
appointment reminders and recalls.  

 Flexibility - ensure your practice is able to provide 
patient’s access (flexibility may be key), face to face 
and/or telehealth may be required.  

 
 

 

 

 

. 

 

. 

Bulk Billing Incentive & Bulk Billing Practice Incentive Program 
To ensure your practice software applies the correct Bulk Billing Incentives,  

make sure MyMedicare status is updated regularly. 
• From 1 November 2025, all Medicare-eligible patients will be eligible for bulk billing incentives.  
• The CCM MBS items are eligible for Bulk Billing Incentive and Bulk Billing Practice Incentive 

Program items which attract additional payments.  
• For more information on Bulk Billing Incentive changes click here  

 
 

Refer WentWest MBS guide for the 

frequently used items including Care 

Planning and incentives This guide 

links item number to MBS criteria, 

descriptor and fact sheets 

https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
https://aus01.safelinks.protection.outlook.com/?url=https%3A%2F%2Fbit.ly%2F4kSlNXe&data=05%7C02%7Cmaha.sedhom%40wentwest.com.au%7C6f82700c4c894a69ff3c08dda7e5a556%7C90dec9afb3c84c3989d2e24c4a9104d3%7C1%7C0%7C638851326955156876%7CUnknown%7CTWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ%3D%3D%7C0%7C%7C%7C&sdata=0%2BQ8ttEO8wzOPYePPPPi6bgI9z0nUFSyEnz54Awyzt0%3D&reserved=0
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4.2 Activity – CCM Claiming Annual Cycle of Care 

Refer to the Chronic Conditions Management MBS User Guide for examples of how CCM management planning items can be used and claimed by general practices.    

  

New GPCCMP 
 

1. Patient Eligibility 

☐ Must have at least one chronic or terminal condition (≥6 months). No age restrictions 

☐ MyMedicare status checked. Discuss MyMedicare patient registration to support care 
continuity with your practice. 

 

2. Develop the Management Plan - GP must see patient 
Practice Nurse, Aboriginal Health Workers, Practitioners may contribute to preparing the plan  

☐ Explain the management plan process, gain informed consent, and collaboratively identify 
the patient's conditions, goals, actions, and required services. 

☐ Discuss review visit frequency and importance. 

☐ Refer to other providers as needed (referral letters, not TCAs). 
 

3. Complete the Plan 

☐ Record consent and provide copy of plan to patient and carer. 

☐ Set review timeline—As clinically appropriate, up to every 3 months.  

☐ Share plan with referred providers (with consent). 

☐ Encourage upload to My Health Record (with consent). 
 

4. Claiming 

☐ Use correct item numbers (e.g. 965 for plan, 967 for review). 

☐ All plan elements must be complete to claim. 

☐ Claiming unlocks up to 5 Medicare-rebated allied health visits 

Identify patient eligible for a NEW Care Plan 
Proactive Patient Engagement 

OR 
Opportunistic Patient Engagement  

GPCCMP Review 

☐ Review existing GPCCMPs every 3 months if clinically appropriate. 

☐ Use MBS item 967 (face-to-face) or 92030 (video) 

☐ Assess patient progress, update goals and services, obtain and record consent 

☐ Share updates with other providers (if applicable) 

☐ Schedule the next review. 
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4.3 Activity – Allied Health Referrals and other GPCCMP considerations 

There are a wide range of services and considerations that can enhance management  

plans. Consider your patient’s unique wellbeing needs and lifestyle goals. 

Refer to HealthPathways for evidence based clinical decision support to inform management planning for each chronic condition.  More info, visit HealthPathways  

Other Management Plan Considerations   

 

Allied Health Referrals 

Consider any allied health 

care your patient may require 

have when writing the 

management plan with them.  

Referral letters to allied 

health providers, 

documenting the care 

required, consistent with the 

referral process for medical 

specialists.  

Allied health providers are 

required to provide a written 

report back to the GP after 

the provision of services (e.g., 

the first service under a 

referral). 

Referrals are valid for 18 

months (unless stated 

otherwise by referring GP).  

Case Conference with care 
team 

MBS 735, 739, 743, 747,     
750, 758 

Self Management or Support 
Groups relevant to chronic 

condition  

Type 2 Diabetes Group 
Services Referral 

for Diabetes Education, 
Dietetics or Exercise 

Physiology 

Social Work Referral 
Consider this where there is 

social issues where additional 
support would benefit chronic 

condition outcome.   

Social Prescribing 
Consider if social 

prescribing may be 
appropriate for this patient.  

Family Support  
Consider if family 

members/ carers require 
any supports.   

Specialist Nurse supports 
such as:  

Breast Care Nurse, 
Continence Nurse, Renal 

Nurse, Respiratory, Cardiac 
etc.  

Blood Tests and other 
periodical tests  

Scripts & other disease 
specific testing e.g., ECG, 

Peak Flow etc.  

Social supports  
Consider social support in 
home environment, social 

connectedness, community 
connections and linkages 

Mental Health Support 
Consider mental health 

needs for individual 
especially if a new diagnosis   

Medical Specialist referral 
if required 

https://westernsydney.communityhealthpathways.org/welcome?returnUrl=%2f
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=735
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=739&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=743&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=747&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=750&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=758&qt=ItemID
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Care plan 

appointment 

booked? Distribute patient info & 

consent forms Book patient with nurse/GP. 
Use BP MD appointment type 

 

Assist with registration 

(HPOS/PRODA) Check HPOS for MBS and 
MyMedicare eligibility 

Book/rebook review 

appointments 

Monitor de-registrations 

Assist with 10997 bookings 

Monitor PRODA/HPOS 

MyMedicare status 

Check upcoming appointments 

4.4 Activity – Roles and Responsibility (Swim Lane workflow) 

 

 

 

 

 Proactive Patient check-in Consultation Patient check-out Follow-up 
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START END 

No 

Yes 

Use this swim lane process map to visually clarify team members roles and responsibilities and who performs each task in the care 
process, identify inefficiencies, and collaboratively redesign workflows to ensure everyone works at the top of their scope. 

Reception  

Practice Nurse/ AHW 

General Practitioner 

Practice Manager 

 

Book a case conference 

Book medication review 

Monitor health metrics (BP, 

BMI) 

Support vaccinations, 

documentation 

Opportunistically eligible 

patients for care planning 

perform screenings, 

observations 

Prepare Care Plan with GP – 

patient goals 

Produce a patient list and/or 

input system prompts 

Book 5 appointments for 10997 

Proactive review patient list or 

system prompts 

Confirm eligibility for 

MyMedicare and care 

plans/review 

Lead care plan creation 
Set review intervals 

Refer to allied health/other 
services 

Update GPCCMP & schedule 

reviews 
 Is case conference needed 

Is medication review is needed 

Review patients file &  
pathology results 

Work with nurse to complete 

Care Plan and bill care plan 
Finalise and bill MBS  

Update workflows/policies Plan CCM/MyMedicare 

 model & billing 

Monitor GP and team 
availability 

Maintain processes for  
MBS compliance 

Monitor MyMedicare 

 targets & MBS usage 

Coordinate team follow-ups Register practice in PRODA Define roles, timelines Train team on MyMedicare 

Update patient engagement 

policy 

Celebrate success as a team 

https://kb.bpsoftware.net/bppremier/Orchid/Management/AppointmentBook/ApptTypes.htm?Highlight=appointment%20type
https://www.medicaldirector.com/help/index.htm?#t=topics-pracsoft%2FAppointment_Types.htm&rhsearch=appointment&rhhlterm=appointment&rhsyns=%20
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4.5 Activity – Sample CCM Nurse workflows   

      Pre-Rollout    Practices with CCM nurse 

  

GP/s

- Get patient's consent after nurse prepares Care Plan

- Providing 3 months review if clinically appropriate

- New Care Plan to be created if significant change to patient's health conditions

- Finalise MBS item/s for receptionists to bill

Nurses

- Prepare Care Plans

- Setting reminders for future reviews

- Booking pateints for health assessments if required

- Patient education focused personal goals / reviews / care plans/ mymedicare registration/ checkups

- Utilising HealthPathways/ GoShare

PM

- Cubiko (if applicable) and PenCs data extraction

- Clinical Management System update from the 1st of July

- Setting Monthly meetings and targets 

- Put updates in WhatsApp channel

- Supply checklist/ resources

- Providing awareness resources at the practice for patients (posters/ TV/ social media/ website/ newsletter)

Receptionists

Upon patient's arrival:

- Coordinate PRODA access 

- Check PRODA / My Health Record and MBS eligibility for each patient

- MyMedicare registration

Patient
- Maintain MyMedicare registration at nomiate practice especially for Chronic condition Management

- Monitor number of Allied health visits claimed via Medicare Express App. 

Team Meeting

- Raise awarness about 
the change 

- Agree on educational 
resources

- Clear communication 
channels internally 

(WhatsApp)

Create leadership team:

- Principle GP

- PM

- CCM nurse  

Meeting Topics:

- Better Patient Care

- Operational Efficiency

- Financial Optimisation

- Implementation Path
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4.6 Activity – CCM Appointment workflows   
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Appendices 
 

5.1 Quality Improvement documentation  

Start by documenting your practice QI team and define your problem and specified a robust Problem Statement. 
 

Practice name: Add your primary healthcare service name here Date: Start date 

QI team: List the team members involved 

Problem:  
Describe why this work is strategically important. What problem is the team addressing? What 
does our data indicate about it, and what are the causes? 

Problem 
Statement: 

Document your succinct problem statement here 

 

Next, move onto the Model for Improvement (MFI), the 'Thinking Part' focuses on the overall improvement strategy, 
while the 'Doing Part' implements changes through the Plan-Do-Study-Act (PDSA) cycle. This model uses PDSA 
cycles to test changes, ensuring measurable and sustainable improvements. Watch short video on MFI and PDSA’s.

 

Step 1: Model for Improvement (Thinking Part) 

1. Goal / Aim: What are we trying to accomplish? 

Develop a S.M.A.R.T. (Specific, Measurable, 

Attainable, Realistic, Time-bound) and people-

crafted Aim Statement. 
 

2. MEASURE: How will we know that a change is 

an improvement? Identify what good looks like 

and develop a measure(s) of success. 

Tip: Use a Run Chart to plot trends. 

 

3. CHANGE IDEAS: What changes can we make 

that will result in an improvement? Engage the 

whole team in formulating change ideas using 

Institute for Healthcare Improvement QI tools 

such as brainstorming, driver diagrams or 

process mapping 

Each change idea may involve multiple small 

rapid PDSA cycles. 

Step 2: Plan-Do-Study-Act (PDSA) (Doing Part) 

1. PLAN: Describe the change idea (what, who, when,   

  where). Predict outcomes and define the  

  data to collect. 

2. DO: Carry out the plan. Collect data. Consider what 

worked well and why? Document any 

unexpected observations, events or problems.  

3. STUDY: Analyse results, compare them to 

predictions, and reflect on what you learned.  

4. ACT: Based on what you learned from the test, consider what you will do next (e.g., adopt, adapt or abandon)? How 

does this inform the plan for your next PDSA?  

For guidance, download template or for support on conducting quality improvement in your primary healthcare 

services, please contact your Primary care Deliver team on support@wentwest.com.au 

Source: Langley, G., Nolan, K., Nolan, T., Norman, C. & Provost, L. 1996, The Improvement Guide, Jossey-Bass, San Francisco, USA 

  

https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
https://www.ihi.org/resources/how-improve-model-improvement
https://www.ihi.org/resources/how-improve-model-improvement
https://www.ihi.org/resources/tools/run-chart-tool
https://app.ihi.org/Events/Attachments/Event-2897/Document-6499/Improvement_Tool_Box.pdf
https://www.ihi.org/resources/tools/driver-diagram
https://www.ihi.org/resources/tools/flowchart
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest_Guidance_MFI_PDSA.pdf
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest-MFI-and-PDSA-Template.dotx
mailto:support@wentwest.com.au
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5.2 PDSA – Team awareness, desire and readiness 

Model For Improvement (MFI) 

AIM 1. What are we trying to accomplish?  

To increase awareness and understanding among the practice team about MyMedicare and Chronic Conditions Management 
(CCM) changes, while defining and documenting each team member’s roles and responsibilities. This will help build readiness 
for change and support sustainable implementation. 

MEASURE(S) 2. How will we know that a change is an improvement?   

• Team members can describe the purpose and benefits of MyMedicare and CCM changes. 

• Documented and agreed team roles and responsibilities. 

• Feedback from the team shows increased confidence and clarity. 

• Team reflects on the process and adapts based on shared learnings.  

CHANGE 
IDEAS 

3. What changes can we make that will result in improvement? 

Idea 1 Hold a team meeting or lunch catch-up to communicate MyMedicare and CCM changes 

Idea 2 Share updates via email or in the staff room. 

Idea 3 Use talking points to explore MyMedicare benefits. 

Idea 4 Facilitate discussion around CCM changes and training needs. 

Idea 5 Define, document, and review team roles and responsibilities regularly. 

Next steps: Each idea may involve multiple short and small PDSA cycles. 

 
Plan-Do-Study-Act (PDSA) 

Idea Plan Do Study Act 

1.1   raise awareness about MyMedicare 
across the practice team. 

• Organise a 15–30 min team meeting or 
informal lunch session. 

• Share talking points and benefits of 
MyMedicare beforehand. 

• Pose open questions for discussion. 
 
Who: Practice manager and GP lead 
When: Week 1 
Where: Staff meeting room 

Held the meeting, 
provided 
handouts, and 
facilitated 
discussion on 
MyMedicare 
benefits and how 
it may impact the 
practice. 

• Team showed interest but 
had questions about 
patient eligibility and 
enrolment. 

• Some team members 
unaware of how it aligns 
with the practice’s current 
strategy. 

• Quick post-meeting 
feedback collected 
showed 80% of attendees 
found the session useful. 

• Plan a follow-up FAQ 
session. 

• Add a MyMedicare 
summary to the 
practice resource 
folder. 

• Ensure key updates 
are emailed post-
session.  

1.2  Clearly define and document each team 
member’s role in CCM and MyMedicare.: 

• Use provided role template. 

• Hold short 1:1 discussions with each 
staff member or in a small team 
huddle. 

• Document and share consolidated 
roles with the team. 
Who: Practice manager 
When: Week 2–3 
Where: In-practice meetings  

Met with all team 
members. Used 
the role template 
to draft roles and 
responsibilities. 
Shared draft with 
staff via email for 
feedback. 

• Most team members 
appreciated the clarity. 

• A few roles needed 
adjusting after real-world 
testing. 

• Team identified gaps in 
CCM training during 
reflection. 

• Schedule 4-week 
check-in to reflect on 
roles. 

• Organise a short 
training session on 
CCM planning. 

• Update and re-share 
finalised roles 
document.  
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5.3 PDSA – Identifying Active Patients & Linking to MyMedicare Program 

Model For Improvement (MFI) 

AIM 4. What are we trying to accomplish?  

Improve the accuracy of active patient identification and ensure 10% of eligible active patients are registered for the 
MyMedicare program within the next six months. 

MEASURE(S) 5. How will we know that a change is an improvement?   

Percentage of active patients identified who are successfully registered with MyMedicare. 

Baseline: 4000 active patients and 50 registered with MyMedicare 
Baseline 
date: 

10/11/2023 

CHANGE 
IDEAS 

6. What changes can we make that will result in improvement? 

Idea 1 Hold a team meeting or lunch catch-up to communicate MyMedicare and CCM changes 

Idea 2 Share updates via email or in the staff room. 

Idea 3 Use talking points to explore MyMedicare benefits. 

Idea 4 Facilitate discussion around CCM changes and training needs. 

Idea 5 Define, document, and review team roles and responsibilities regularly. 

Next steps: Each idea may involve multiple short and small PDSA cycles. 

 
Plan-Do-Study-Act (PDSA) 

Idea Plan Do Study Act 

1.1 Practice Manager to extract 
a list of patients flagged as 
active patients who are not 
registered for MyMedicare 
by 1/11/23. Prediction: 
there will be patient that are 
inactive. 

Conduct the first round of 
active patient verification 
for 50 patients and 10 were 
inactive as predicted. 15 
were enrolled but 
MyMedicare status was 
missing. Update records to 
correct status and register 
them for MyMedicare. 

• Conduct a bulk archive of 
inactive patients. Bulk 
import MyMedicare 
enrolments to PMS 
instead of manual/ per 
patient.  
Incorporate MyMedicare 
enrolment discussions 
during patient contact 
and pre-plan for 
upcoming appointments 

Practice Manager to extract 
a list of patients flagged as 
active patients who are not 
registered for MyMedicare 
by 1/11/23. Prediction: 
there will be patient that are 
inactive. 

1.2 Conduct a bulk archive of 
inactive patients 
Prediction: need to this 
regularly. 

Conduct the first round of 
active patient verification 
for 50 patients and 10 were 
inactive as predicted. 15 
were enrolled but 
MyMedicare status was 
missing. Update records to 
correct status and register 
them for MyMedicare. 

• Conduct a bulk archive of 
inactive patients. Bulk 
import MyMedicare 
enrolments to PMS 
instead of manual/ per 
patient.  
Incorporate MyMedicare 
enrolment discussions 
during patient contact 
and pre-plan for 
upcoming appointments 

Practice Manager to extract 
a list of patients flagged as 
active patients who are not 
registered for MyMedicare 
by 1/11/23. Prediction: 
there will be patients that 
are inactive. 
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5.4 PDSA – CCM and MyMedicare 

Model For Improvement (MFI) 

AIM 1. What are we trying to accomplish?  

Improve the completion of management plans for MyMedicare-registered patients with chronic conditions by 20% in the next 
3 month.  

MEASURE(S) 2. How will we know that a change is an improvement?   

Proportion of chronic condition patients who are registered with MyMedicare and have an active care plan. 

CHANGE 
IDEAS 

3. What changes can we make that will result in improvement? 

Idea 1 
Display MyMedicare posters in waiting areas and train all staff to engage patients in conversations about 
MyMedicare. 

Idea 2 
Use data tools (e.g. CAT4) to identify patients with chronic conditions who are not yet registered with 
MyMedicare. 

Idea 3 Send SMS or letters to identified patients, outlining the benefits of MyMedicare and management plan eligibility. 

Idea 4 
Flag eligible patients in the practice management system to prompt MyMedicare discussions during 
appointments. 

Next steps: Each idea may involve multiple short and small PDSA cycles. 

 

Plan-Do-Study-Act (PDSA) 

Idea Plan Do Study Act 

1.1 Practice Nurse to flag patient 
files of those likely to benefit 
from MyMedicare registration. 
Practice Manager to ensure all 
staff are trained and equipped 
with key messages for patient 
conversations. Prediction: 
Flagging and staff messaging will 
increase MyMedicare 
registrations. 

Begin flagging eligible patients 
in the system. When these 
patients attend appointments, 
GPs initiate discussions about 
MyMedicare. Share 
informational materials via 
email or print. 

Monitor staff feedback 
and patient responses. 
Record the number of 
patients flagged, 
engaged, and 
successfully registered. 
Identify any challenges 
or missed opportunities. 

Adjust flagging or 
scripting processes as 
needed. Refine 
communication 
methods (e.g. SMS vs. 
in-person). Plan next 
PDSA cycle to build on 
what worked well. 

2.1 Conduct a data cleansing 
exercise using CAT4 to identify 
patients with diagnosed or 
potentially undiagnosed chronic 
conditions. Prediction:  improved 
patient identification 

Reviewed 50 patient records 
(e.g. diabetes cohort) to verify 
diagnoses and uncover 
inconsistencies or missing 
coding. 

There may be some 
discrepancies or 
missing data points in 
the initial search results, 
particularly if the 
chronic conditions are 
under-diagnosed or not 
appropriately coded 
(see Indicated 
Diagnoses report) . This 
will require follow-up 
with clinicians to ensure 
correct data entry and 
comprehensive patient 
records. 

Standardise coding 
practices within the 
PMS. Use CAT4 
condition Data 
Mapping  
 
Train staff to enter 
coded diagnoses (no 
free text) and use 
provisional diagnosis 
fields appropriately. 
Scale this activity to 
broader cohorts.  
 

2.2 Train clinical staff on accurate 
coding procedures using CAT4, 
Best Practice, and Medical 
Director tools. Prediction: 
improved management plan 
eligibility identification. 
Prediction: Training will improve 
coding accuracy and 
management plan eligibility. 

Delivered staff training 
sessions. Provide resources 
and visual guides. Introduce 
standardised coding templates. 

Track updates in 
chronic disease coding 
and increases in 
accurately coded 
diagnoses. Review 
feedback from 
clinicians. 

Continue refining 
training materials. 
Monitor coding trends 
monthly. Use coding 
data to trigger 
management plan 
reminders and patient 
recalls. 

3.1 Use CAT4 to identify 
MyMedicare-registered patients 
due for a GPMP/TCA. Aim to 
optimise both management 
planning and MBS claiming. 
Prediction: Recalls will boost 
attendance 

Review a sample list of 50 
patients with diabetes. Initiate 
recalls via SMS, phone, or 
opportunistic prompts during 
visits. 

Assess how many 
patients responded to 
recalls and completed 
management plans. 
Document process 
issues or patient 
feedback. 

Refine recall 
messaging and 
intervals. Introduce 
automated reminders 
and integrate review 
scheduling into routine 
workflows. 

https://help.pencs.com.au/display/CG/Data+Cleansing
https://help.pencs.com.au/display/ds/Indicated+Diagnoses+Report
https://help.pencs.com.au/display/ds/Indicated+Diagnoses+Report
https://help.pencs.com.au/display/ADM/Data+Mapping
https://help.pencs.com.au/display/ADM/Data+Mapping
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5.5 PDSA – Reducing Missed Appointments for Management plan reviews 

Model For Improvement (MFI) 

AIM 1. What are we trying to accomplish?  

Reduce missed chronic condition management plan review appointments by 20% in the next 3 month.  

MEASURE(S) 2. How will we know that a change is an improvement?   

➢ Reduction in missed chronic condition review appointments (target: 25% reduction over 6 weeks). 
➢ Increase in rebooked review appointments. 
➢ Increase in patient engagement with digital education materials (e.g., GoShare). 
➢ Number of patients with documented personalised care goals. 

CHANGE 
IDEAS 

3. What changes can we make that will result in improvement? 

Idea 1 
Implement structured follow-up processes (calls, letters) for missed appointments using tracking tools like BP, 
Pracsoft, or Cubiko. 

Idea 2 Assign a nurse or designated team member to track and rebook missed reviews. 

Idea 3 Use GoShare or similar platforms to re-engage at-risk patients through videos and resources. 

Idea 4 
Introduce personalised, patient-centred goals into management planning to boost motivation and follow-up 
rates. 

Next steps: Each idea may involve multiple short and small PDSA cycles. 

 

Plan-Do-Study-Act (PDSA) 

Idea Plan Do Study Act 

1.1 Develop a structured follow-up 
workflow using BP and Cubiko 
to identify and act on missed 
chronic condition reviews. 
Create standard letter and call 
templates. Prediction: 
A consistent follow-up process 
will reduce missed appointments 
by at least 20% within 6 weeks. 
 

Trial the process for 4–6 weeks 
with admin staff using the 
templates to follow up with 
patients who missed reviews. 

Monitor reduction in 
missed appointments. 
Cubiko showed a 25% 
reduction over 6 weeks. 
Staff reported more 
confidence in 
consistency of follow-
up. 

Adopt the follow-up 
process as policy. 
Train all admin staff. 
Automate reporting 
and follow-up tracking 
in Cubiko or equivalent 
system. 

2.1 Test whether having a nurse or 
admin staff responsible for 
tracking missed reviews 
improves rebooking outcomes. 
Prediction: Assigning a nurse to 
manage rebooking will improve 
review attendance rates 
compared to ad hoc admin 
follow-up. 

Trial with rotating admin and 
nursing staff for 4 weeks. Track 
rebooked patients. 

Nurse-led follow-up 
achieved higher 
rebooking rates 
compared to admin-
only. Fewer patients 
were lost to follow-up. 

Assign this task 
permanently to nursing 
staff, with admin 
backup. Document 
responsibilities in staff 
workflows. 

2.2 Use GoShare to send targeted 
educational videos/resources to 
patients who have missed 
reviews or show signs of 
disengagement. Prediction: 
Sending GoShare resources will 
re-engage at least 40% of 
patients who previously missed 
their review appointment. 

Send GoShare resources to at-
risk patients. Monitor 
engagement using platform 
analytics. 

~45% engagement rate. 
Patients who interacted 
with content were more 
likely to rebook and 
attend their next 
appointment. 

Expand GoShare use to 
other cohorts (e.g. 
mental health, lifestyle 
conditions). Develop 
SOPs for using digital 
resources when 
disengagement risk is 
flagged. 

3.1 Introduce patient-centred goal-
setting (e.g. weight, activity, 
mental health) during care plan 
reviews to improve follow-
through. Prediction: 
Patients with documented 
personal goals will be more likely 
to attend follow-up reviews and 
report higher satisfaction. 

Implement this with a small 
cohort of patients during 
routine reviews. Document 
goals in the care plan. 

Patients with 
personalised goals 
showed improved 
motivation and better 
follow-up attendance. 
Positive feedback was 
noted from nurses.. 

Incorporate 
personalised goals into 
all care plan templates. 
Use CAT4 reports to 
monitor patient 
progress monthly. 
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5.6 Measuring Outcomes – Audit Worksheet   

1. Choose the QI activity measure that aligns with your practice goal 

2. Enter a practice target and baseline for each QI activity measure in the table below 

3. Track your progress over time by entering a result for reporting period. 

4. Use run chart to plot results over time.  

Measure:  
Practice 
Target 

Baseline 
date 

Result 1 
date 

Result 2 
date 

Result 3 
date 

Result 4 
date 

Example PIPQI # (%) % # (%) # (%) # (%) # (%) 

MyMedicare registered patients       

MyMedicare registered and CCM patients       

Patients due for CCM or review       

Patients with ‘Diabetes’       

Patients with a billed Care Plan in the past 
12m 

      

Insert QI activity measure       

Insert QI activity measure       

Insert QI activity measure       

* Per RACGP, an active patient has 3+ visits in 2 years. This filter may exclude new or at-risk patients who don't see their GP regularly 

  

Measuring Outcome CPD Tip:  Collaborate as a team to generate a CAT4 list of patients per GP.  

http://help.pencs.com.au/display/CR/Identify%2Bpatients%2Bseen%2Bby%2Ba%2Bparticular%2Bprovider%2Bor%2Bgroup%2Bof%2Bproviders
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5.7 Group reflection – after completing activities 

 

As a team, analysis and review baseline data results and discuss change ideas and actions.  
Use PDSA cycles to test and measure change ideas 

The degree to which the learning needs were met: 

  Not met 
  Partially met 
  Entirely met 

 

To what degree this activity was relevant to your 
practice: 

 Not met 
 Partially met 
 Entirely met 

 

What did you learn?  What changes would you make to your practise as a result? 

For example,  

• Has patient engagement increased through education efforts? 
• Which educational strategies were most effective? 
• Have MyMedicare registrations improved following engagement efforts? 
• Do relevant team members know how to send out GoShare patient resources, videos and apps? 
• What barriers were encountered in patient engagement? 

RACGP CPD: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection. 

 

https://mycpd.racgp.org.au/log
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5.8 Useful contacts 
 

WentWest - WSPHN 
02 8811 7117   
support@wentwest.com.au  
www.wentwest.com.au 

Provider Digital Access 
(PRODA) PRODA  
 

1800 700 199 (option 1) 
proda@servicesaustralia.gov.au 
PRODA Information 
Training: PRODA eLearning  

Health Professional Online 
Services (HPOS) 

132 150 (option 6) 
HPOS Access  
Training: HPOS eLearning 

Medicare Provider Enquiries 
(Medicare Programs) 

Phone: 132 150 (Option 2 - Claiming, payment, Provider Registration, 
MyMedicare and Organisation Register enquiries) 

Services Australia Incentive 
Program 

1800 222 032 
Incentive Program Information   
Training: Incentive Programs eLearninghttps://www.health.gov.au/our-
work/increases-to-bulk-billing-incentive-payments 

MBS 

13 21 50  
askmbs@health.gov.au 
MBS online 
Training: MBS Training eLearning 

Healthdirect  

1800 580 771 
videocallsupport@healthdirect.org.au 
Registration Form Video Call  
 Video Call  

Australian Immunisation 
Register 

1300 650 039  
air@humanservices.gov.au   

Department of Veteran Affairs 1800 550 457 

Services Australia  
eBusiness 

1800 700 199  
ebusiness@humanservices.gov.au  

Health Identifiers Service 

1800 762 993 
www.pencs.com.au 
support@pencs.com.au 
Booking for installation: support online  
Training: Recorded webinars:  
Searches: CAT4 recipes  

Medical Director 
1300 300 161 
www.medicaldirector.com 

Best Practice 
1300 40 1111 
www.bpsoftware.net  
support@bpsoftware.net 

Translating and Interpreting 
Service (TIS National) 

131 450 

My Aged Care 1800 200 422 

MyGov help desk 132 307 - option 1 

eRx 1300 700 921 

Healthlink 1800 125 036 

My Health Record 1800 723 471 

WSLHD GP Support Line 
1300 972 915 
Direct Access to Rapid Access Stabilisation Service; Diabetes, Cardiology and 
Respiratory  

WSLHD Public Health Unit 
02 9840 3603 
Cold Chain Breach/Vaccine Enquiries  

Urgent Care  1800 022 222 (Healthdirect) 
 

mailto:support@wentwest.com.au
https://www.wentwest.com.au/
mailto:proda@servicesaustralia.gov.au
https://www.servicesaustralia.gov.au/proda-provider-digital-access
https://hpe.servicesaustralia.gov.au/provider-digital-access.html
https://www.servicesaustralia.gov.au/hpos?context=20
https://hpe.servicesaustralia.gov.au/eLearning_HPOS.html
https://hpe.servicesaustralia.gov.au/eLearning_HPOS.html
https://www.servicesaustralia.gov.au/practice-incentives-program?context=20
https://hpe.servicesaustralia.gov.au/eLearning_IP.html
https://hpe.servicesaustralia.gov.au/eLearning_IP.html
https://www.health.gov.au/our-work/increases-to-bulk-billing-incentive-payments
https://www.health.gov.au/our-work/increases-to-bulk-billing-incentive-payments
mailto:askmbs@health.gov.au
https://www9.health.gov.au/mbs/search.cfm
https://hpe.servicesaustralia.gov.au/eLearning_MBS.html
mailto:videocallsupport@healthdirect.org.au
https://www.healthdirect.gov.au/video-call-reg
https://www.healthdirect.gov.au/video-call-reg
https://help.vcc.healthdirect.org.au/95525-getting-set-up-with-video-call-for-the-first-time/webinars
mailto:air@humanservices.gov.au
mailto:ebusiness@humanservices.gov.au
http://www.pencs.com.au/
mailto:support@pencs.com.au
https://www.pencs.com.au/support/
https://vimeo.com/pencs
https://help.pencs.com.au/display/CR/CAT+RECIPES
http://www.medicaldirector.com/
http://www.bpsoftware.net/
mailto:support@bpsoftware.net
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5.9 MBS Quick Guide  
 

This guide outlines the frequently used Medicare Benefits Schedule (MBS) items with each item number linked MBS 

criteria, descriptor and fact sheets. Click here for a full list of MBS items. 

  

CHRONIC CONDITIONS MANAGEMENT (CCM) Face to Face Telehealth* 

GP chronic condition management plan** (EVERY 12 MONTHS if clinically relevant)  965† 92029† 

GP chronic condition management plan Review** (EVERY 3 MONTHS if clinically relevant) 967† 92030† 

Practice Nurse /Aboriginal Health Practitioner follow-up services for a patient 
with a chronic condition  (5 PER YEAR) 10997 

Phone 93203 
Video 93201 

Practice Nurse/Aboriginal Health Practitioner follow-up services for Aboriginal 
and Torres Strait Islander patients    (10 PER YEAR) 10987 

Phone 93202 
Video 93200 

Domiciliary Medication Management Review (DMMR) (ANNUALLY) 900  

GP contribution to multidisciplinary plan – Community (EVERY 3 MONTHS) 729 92026 

GP contribution to multidisciplinary plan (MCP) – RACF (EVERY 3 MONTHS)  731 92027 

Residential Medication Management Review (RMMR) (ANNUALLY)  903  

† MyMedicare registered patients can only access these services at their MyMedicare general practice 
*Telehealth (Video Consults) and *Telephone (Phone Consults) available to Medicare-eligible patients with an 
established practice relationship who have attended in-person within the past year can access services.  
(Exceptions include children under 12 months, COVID-19 isolation, natural disaster areas, Aboriginal Medical 
Services, urgent after-hours care, homelessness, or services for blood-borne viruses, sexual/reproductive health, or 
TOPIC. The 30/20 rule applies to telephone items.) 
**Patients with a General Practitioner Chronic Disease Management Plan/Review can access the following MBS 
services: 

• Allied Health Services: Up to 5 individual sessions per year (10 for Aboriginal or Torres Strait Islander 
patients). 

• Nurse or Health Practitioner Services: Up to 5 services annually, provided on behalf of a doctor. 

• Type 2 Diabetes Care: If eligible, up to 8 yearly group sessions for dietetics, education, or exercise. 

 

CASE CONFERENCING 

Case Conference GP organises (MAX. 5 TIMES PER PATIENT PER CALENDAR YEAR)  735  739  743 

Case Conference GP participating (MAX. 5 TIMES PER PATIENT PER CALENDAR YEAR)  747      750  758 

 

BULK BILLING INCENTIVES (BBI) 
BBI (MBS MN.1.1) can be claimed when you bulk bill a child under 16 or a Commonwealth Concession 
Card holder. 
MyMedicare enrolled patients only at their enrolled practice 

• Level C, D, E (Telehealth*) 

• Level C, D (Telephone*) 

75880† 

• Level B, C, D, E (Face to Face) 

• Level B (Telehealth*, Telephone*) 
75870 

All other eligible services not covered below  (refer MBS MN.1.1) 10990 

MBS ONLINE 
• Search for Item 

Number  
• Fact Sheets  
• Updates (XML Files) 
• MBS News 

Eligibility  
Ensure patient meets billing 
criteria.  

• HPOS MBS checker  
• My Health Record  
• Topbar MBS app  

More information 

• www.mbsonline.gov.au  

• Contact MBS 13 21 50 
askMBS@health.gov.au 

• Western Sydney 
HealthPathways - MBS Items 

To ensure your 

practice software 

applies the correct 

Bulk Billing 

Incentives, make 

sure MyMedicare 

status is updated 

regularly. 

https://bit.ly/4kSlNXe
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=10997&qt=item&criteria=10997
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93203&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93201&qt=item&criteria=93201
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=10987
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93202&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=93200&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=900
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=729&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=92026
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=731&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=92027
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=903&qt=ItemID
https://www.health.gov.au/our-work/mymedicare/practices-and-providers
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Telehealth-Updates-April%202023
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/Factsheet-Telehealth-Updates-April%202023
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=735
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=739&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=743&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=747&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=750&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=758&qt=ItemID
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=note&qt=NoteID&q=MN.1.1
https://www.servicesaustralia.gov.au/concession-and-health-care-cards
https://www.servicesaustralia.gov.au/concession-and-health-care-cards
https://www.health.gov.au/our-work/mymedicare
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=75880
https://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&q=75870&qt=item&criteria=75870
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=note&qt=NoteID&q=MN.1.1
http://www9.health.gov.au/mbs/fullDisplay.cfm?type=item&qt=ItemID&q=10990
https://www9.health.gov.au/mbs/search.cfm
https://www9.health.gov.au/mbs/search.cfm
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/factsheet-current
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/downloads
https://www.mbsonline.gov.au/internet/mbsonline/publishing.nsf/Content/news
https://www.servicesaustralia.gov.au/check-mbs-item-numbers?context=20
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record
https://help.pencs.com.au/display/TUG/MBS+App
http://www.mbsonline.gov.au/
mailto:askMBS@health.gov.au
https://westernsydney.communityhealthpathways.org/310515.htm
https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
https://www.health.gov.au/our-work/upcoming-changes-to-bulk-billing-incentives-in-general-practice
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